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Lôøi Töïa 
  

 Taäp san Cheá taïo maùy soá ñaàu tieân ñaõ ra maét vaøo ngaøy Nhaø giaùo Vieät Nam 20/11. Ñaõ coù 
hôn 80 baûn ñöôïc phaùt haønh, chuû yeáu laø cho sinh vieân caùc lôùp 42CT1 vaø 42CT2. Maëc duø 
ban bieân taäp ñaõ coù nhieàu coá gaéng song khoâng theå traùnh khoûi nhöõng thieáu soùt. Maëc duø vaäy, 
ban bieân taäp cuõng ñaõ nhaän ñöôïc söï khích leä töø caùc caáp laõnh ñaïo Khoa vaø Tröôøng.  

 Cho ñeán nay, ban bieân taäp ñaõ nhaän ñöôïc nhieàu söï goùp yù töø caùc Thaày Coâ cuõng nhö töø 
sinh vieân. Moät trong nhöõng yù kieán töø phía sinh vieân laø mong muoán taäp san ra haøng thaùng. 
Ñaây cuõng laø mong muoán ban ñaàu cuûa chuùng toâi, nhöng qua quaù trình baét tay vaøo coâng vieäc 
chuùng toâi gaëp phaûi raát nhieàu khoù khaên maø chuû yeáu laø löïc löôïng coøn moûng vaø thôøi gian haïn 
cheá. Tuy nhieân chuùng toâi seõ nghieân cöùu vaán ñeà naøy khi coâng vieäc ñi vaøo oån ñònh. Chuùng 
toâi voâ cuøng bieát ôn quyù Thaày coâ vaø caùc baïn sinh vieân ñaõ ñoùng goùp yù kieán. Chuùng toâi mong 
muoán nhaän ñöôïc nhieàu yù kieán hôn nöõa ñeå taäp san ngaøy caøng hoaøn thieän hôn. 

 Nhaân dòp naêm môùi, caâu laïc boä xin kính chuùc Quyù thaày coâ maïnh khoûe, thaønh ñaït vaø coâng 
taùc toát. Chuùc caùc baïn sinh vieân maïnh khoûe, coù moät muøa thi thaønh coâng! 
 
                                  CHUÛ TÒCH CAÂU LAÏC BOÄ 
                                             Nguyeãn Vaên Töôøng 
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Tin hoạt ñộng Câu lạc bộ - ðoàn 

 - Ngày 03/12/2003 câu lạc bộ Chế tạo máy ñã 
tiến hành trao giải cho cho các sinh viên ñạt giải 
trong cuộc thi Olimpic Chế tạo máy lần 2. Kết quả 
như sau : 
 Giải nhất : Lâm Văn Sơn - lớp 42CT2 
 Giải nhì  : Mai Duy Hưng - lớp 42CT1 
 Giải ba :   Phạm Văn Thi - lớp 42CT1 
                    ðặng Giang Quỳnh Sơn - 42CT1 
 Giải khuyến khích : 
                    Võ Châu Danh - lớp 42CT1 
                    Phạm Văn Minh – 43ðLTT 
 Phần thưởng là những món quà nhỏ tuy nhiên 
rất có ích cho học tập. 
 - Ngày       bộ môn Cơ học ñã tổ chức thi 
Olimpic cơ học lần 1. Tham gia cuộc thi có hơn 70 
sinh viên tham gia. Kết quả cuộc hti như sau : 
 Giải nhất :  
 Giải nhì  : 
 Giải ba : 
 Giải khuyến khích : 
 - Ngày 03/12/2003 ðoàn khoa cơ khí ñã tổ 
chức quyên góp tiền ủng hộ người nghèo. Kết quả 
ñã quyên góp ñược 887.000 ñồng. Ngoài ra từng 
cá nhân sinh viên cũng quyên góp theo ñơn vị lớp 
ñể ủng hộ quỹ này. 
 - Nhằm trang bị kỹ năng thực hành ño lường 
cho sinh viên chế tạo khoá 41 trước khi ra trường, 
lớp thực hành ño lường miễn phí ñã ñược tổ chức 
ngày 06/01/2004. Ngoài việc thực hành trên những 
dụng cụ cầm tay thông thường, sinh viên còn ñược 
thực hành trên máy chiếu hình, máy ño ñộ nhám 
bề mặt và một số dụng cụ ño cao cấp khác. Tham 
gia lớn này có 16 sinh viên của hai lớp 41CT1 và 
41CT2. 
 - Năm 2003 vừa qua ðoàn khoa Cơ khí ñã có 2 
ñoàn viên ưu tú ñược kết nạp ðảng. ðó là sinh 
viên Mai Văn Hồng (41CT) và sinh viên Nguyễn 
Văn Luận (41TT). 
 - Trong ñợt tổng kiểm tra ðoàn vụ vừa qua, 
ðoàn khoa Cơ khí  ñược ðoàn Trường ñánh giá 
ñạt loại khá. 
 

Chế tạo thành công máy gieo lúa tự ñộng 
 Kỹ sư Phạm Hoàng Thắng – Giám ñốc công ty 
TNHH Hoàng Thắng (TP Hồ Chí Minh) vừa chính 
thức công bố chế tạo thành công loại máy gieo lúa 
tự ñộng bằng nhựa. Với máy gieo lúa tự ñộng, 
người nông dân chỉ cần bỏ lúa vào những bầu 
xoay, sau ñó thong thả kéo máy gieo lúa tự ñộng 
trên ruộng, lúa giống tuần tự rơi ñều trên khắp 
ruộng, giảm ñáng kể sức lao ñộng. ðề tài trên ñã 
ñược Hiệp hội Nhựa TP Hồ Chí Minh trao giải ñặc 

biệt tại Hội thi sáng tạo khoa học kỹ thuật TP Hồ Chí 
Minh tháng 5-2003, và ñoạt HCV trong Hội chợ triển 
lãm nông nghiệp Việt Nam. Hiện Hiệp hội Nhựa TP 
Hồ Chí Minh ñang bảo trợ cho Công ty sản xuất hơn 
30.000 máy phục vụ trong nước. 
      Theo Lao ðộng 

Chế tạo thành công máy vắt sữa bò 

 ðề tài "Nghiên cứu chế tạo máy vắt sữa bò" ñã 
ñược Hội ñồng Nghiệm thu do Sở Khoa học Công 
nghệ và Môi trường TP HCM ñánh giá ñạt loại khá. 
ðây là loại máy do Viện Cơ học Ứng dụng Thiết kế 
chế tạo từ mẫu máy nước ngoài cho phù hợp với ñiều 
kiện Việt Nam.  
 Qua thử nghiệm tại các hộ nông dân nuôi bò sữa ở 
các vùng ngoại thành cho thấy, chất lượng sữa sau 
khi vắt ñảm bảo vệ sinh. Máy có giá trị 10 triệu ñồng 
(máy ngoại 12-15 triệu ñồng).  
   Theo Người Lao ðộng 

Du học tại chỗ ngành công nghệ hàn, ñúc 
 Trường kỹ thuật cơ khí luyện kim Sài Gòn 
(Saimete) và Học viện công nghệ thương mại Yung-
ta (ðài Loan) vừa ký kết chương trình du học tại chỗ 
lấy bằng chuyên viên kỹ thuật cao các ngành công 
nghệ hàn, công nghệ ñúc, cơ học biến dạng và cán 
kim loại... ðối tượng là học sinh tốt nghiệp PTTH và 
sinh viên.  
 Thời gian học là 3 năm. Trong 2 năm ñầu học viên 
học tại Việt Nam với các ngành khoa học cơ bản, kỹ 
thuật cơ sở, chuyên môn và Hoa văn. Sau khi hoàn 
thành giai ñoạn này, họ sẽ theo học năm cuối ở Yung-
ta.  
 Văn bằng do Yung-ta cấp. Học phí tại Việt Nam là 
500-600 USD/năm và tại ðài Loan 3.500 USD/năm 
(cả ăn ở). Sau khi tốt nghiệp, sinh viên có thể ở lại 
làm việc tại ðài Loan hoặc ở các khu công nghiệp, 
khu chế xuất của ðài Loan tại Việt Nam. 

  Theo Vnexpress 

TP HCM sẽ có một khu công nghiệp sản xuất 
ôtô, ñóng tàu 

 Phó Chủ tịch UBND TP HCM Mai Quốc Bình 
cho biết, thành phố ñã dành khoảng 50-70 ha tại Củ 
Chi ñể xây dựng khu công nghiệp cơ khí. Một Tổng 
công ty nhà nước ngành cơ khí sẽ ra ñời với hoạt 
ñộng ban ñầu là sản xuất xe buýt, sau ñó mở rộng sản 
xuất các loại ôtô khác, ñóng tàu... 
 TP cũng ñề nghị Bộ Công nghiệp xem xét trình 
Thủ tướng Chính phủ cho phép Xí nghiệp cơ khí giao 
thông Quận 5 thực hiện dự án sản xuất, lắp ráp xe 7 
chỗ ngồi và ôtô cỡ nhỏ dạng CKD2 mang thương 
hiệu Việt Nam ñể ñáp ứng nhu cầu thay thế xe lam và 
xe buýt ñã quá hạn sử dụng. ðây là dự án có tổng giá 
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trị ñầu tư 76,47 tỷ ñồng với năng lực sản xuất 400 
xe/năm, dự kiến hoàn thành trong năm 2004.  
    Theo Tuổi Trẻ 

Sẽ có nhà máy thép lớn nhất Việt Nam 
 

 Ngày 17/12/2003, Công ty BlueScope (Úc) ñã 
khởi công xây dựng Nhà máy thép mạ kim loại và 
mạ màu tại Khu Công nghiệp Phú Mỹ 1, tỉnh Bà 
Rịa - Vũng Tàu. ðây là nhà máy sản xuất thép lớn 
nhất và hiện ñại nhất Việt Nam. 

 
Logo mới của Công ty BlueScope. 

 Dự án Nhà máy thép của BlueScope ñược Bộ 
Kế hoạch và ðầu tư cấp phép vào tháng 8/2003. 
Với số vốn ñầu tư 150 triệu USD, Nhà 
máy ñược xây dựng theo tiêu chuẩn quốc tế, trong 
ñó sử dụng công nghệ mạ hợp kim kẽm nhôm tiên 
tiến của Úc ñể ñạt công suất 125.000 tấn thép mạ 
hợp kim kẽm nhôm và 50.000 tấn thép sơn/năm.  
 Ông Michael Courtnail, Giám ñốc thị trường 
châu Á về xây dựng và sản xuất của BlueScope, 
cho biết ñây là dự án ñầu tư lớn nhất của công ty 
tại khu vực châu Á kể từ khi công ty này chính 
thức niêm yết trên thị trường chứng khoán Úc hồi 
tháng 7 năm ngoái. Và ñây cũng là kế hoạch mở 
rộng thị phần của công ty tại thị trường châu Á.  
 Dự kiến Nhà máy sẽ bắt ñầu ñi vào hoạt ñộng 
năm 2006, tạo việc làm cho khoảng 230 lao ñộng 
Việt Nam. Hai nhãn hiệu chính ñược sản xuất tại 
Nhà máy này là thép tấm Clean Colorbond và thép 
Zincalume. Sản phẩm làm ra sẽ cung cấp cho thị 
trường trong nước cũng như xuất khẩu.  
 Sản phẩm thép mạ kim loại và màu là loại sản 
phẩm mới ñược sử dụng cho các công trình xây 
dựng công nghiệp, dân dụng cao cấp. Một số công 
ty Việt Nam ñã sản xuất loại sản phẩm này nhưng 
với tiêu chuẩn thấp hơn và sản lượng không ñủ 
cung ứng nhu cầu.  
 Năm 1993, BlueScope vào Việt Nam thành lập 
hai nhà máy sản xuất thép ở TP.HCM và Hà Nội 
tên gọi BHP Lysaght Vietnam, sau ñổi là 
BlueScope Lysaght Vietnam. Hai nhà máy này 
ñược ñầu tư với qui mô nhỏ và thuần túy gia công 
sản phẩm thép bằng nguyên liệu nhập từ chính 
hãng. 
 Theo dự báo của Bộ Công nghiệp, nhu cầu sử 
dụng thép của Việt Nam vào khoảng 5 triệu tấn 

trong năm 2003, tăng 12,4% so với năm ngoái. Hơn 
50% lượng thép này phải nhập từ nước ngoài, bao 
gồm thép phôi và thành phẩm.  
     VietNamNet 

Vật liệu không giãn nở 

 
Một mảnh hợp kim mới. 

 Các nhà khoa học Mỹ vừa chế tạo một loại hợp 
kim không giãn nở hoặc co lại khi bị nung nóng. 
Ngoài ra, nó còn có tính dẫn ñiện. Vật liệu này có thể 
ñược sử dụng ñể sản xuất các linh kiện luôn phải trải 
qua những dao ñộng lớn về nhiệt ñộ chẳng hạn như 
ñộng cơ, cơ cấu truyền ñộng từ và trong ngành vũ trụ.  
 Phần lớn vật liệu giãn nở khi bị nung nóng và chỉ 
có một số ít co lại. Nếu ñược kết hợp với nhau, hai 
loại vật liệu ñó có thể hình thành một hợp chất không 
giãn nở chút nào khi nhiệt ñộ thay ñổi. Những hợp 
chất không giãn nở như vậy rất có ích bởi chúng có 
thể chịu ñựng ñược dao ñộng nhanh về nhiệt ñộ. 
 Mercouri Kanatzidis và ñồng nghiệp thuộc ðH 
Michigan State ñã phát hiện ra rằng một loại vật liệu 
làm từ ytterbium, gallium và germanium không giãn 
nở khi nóng lên. Ngoài ra, hợp chất mới còn dẫn ñiện. 
Vật liệu không giãn nở trước ñây thường là chất cách 
ñiện. Hợp kim mới không giãn nở trong khoảng từ 
100 tới 400 ñộ Kelvin. 
 Kanatzidis và ñồng nghiệp cho rằng khi hợp kim 
mới nguội ñi, các electron, bị bật bãi trong dãy hoá trị 
liên quan tới nguyên tử gallium, di chuyển tới nguyên 
tử yttterbium. Nguyên tử ytterbium giãn nở khi chúng 
nhận các electron này. Mặc khác, nguyên tử gallium 
co lại. Vì các nguyên tử gallium chỉ co lại chút ít nên 
dẫn tới hệ số giãn nở nhiệt dương theo một hướng.  
 Co giãn do nhiệt là vấn ñề ñau ñầu ñối với các nhà 
thiết kế tàu vũ trụ bởi nó có thể tạo ra các lỗ nhỏ 
trong kim loại chế tạo tàu. Kim loại ñó có thể giãn nở 
khi tàu trở lại khí quyển trái ñất. Kanatzidiss cho biết: 
''Chúng tôi hy vọng kết quả nghiên cứu sẽ giúp giới 
khoa học tìm kiếm vật liệu không co giãn trong số 
các chất bán dẫn và hợp kim mà chưa có ai nghĩ ra 
trước ñây''. 
     Theo Vnexpress 
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Bơm tự mồi thế  hệ 3 
 Tiến sĩ Trần Văn Công và các ñồng sự ñã chế 
tạo thành công bơm tự mồi thế hệ 3 phục vụ nông 
nghiệp. Nhờ bộ tự mồi này, bơm ly tâm nông 
nghiệp ñã hoàn toàn có thể vận hành tự ñộng hóa. 
Tiến sĩ Công, Phòng tự ñộng hóa, Viện Khoa học 
thủy lợi thuộc Bộ Nông nghiệp và Phát triển nông 
thôn cho biết những máy bơm ly tâm ñược sử dụng 
trong nông nghiệp là loại có trục nằm ngang, cánh 
bơm nằm cao hơn mặt nước bể hút nên khi vận 
hành bắt buộc phải mồi nước ñầy kín ống hút và 
 buồng bơm. Các biện pháp mồi nước phổ biến 
làm mồi bơm thủ công bằng sức người; mồi bơm 
bằng bể chứa nước phụ và mồi bơm bằng bơm hút 
chân không. Việc áp dụng các biện pháp mồi trên 
mất rất nhiều nhân công, sức lao ñộng bỏ ra lớn, 
hơn nữa nếu dùng máy mồi chân không rất cồng 
kềnh. 
 Lần ñầu tiên, thiết bị mồi nước máy bơm ly tâm 
nông nghiệp ñược Viện Khoa học thủy lợi chế tạo 
thành công vào năm 1996. Bộ mồi tự chế thế hệ 1 
kiểu vai bò cho bơm ly tâm nông nghiệp có lưu 
lượng 500 - 1.000 m3/giờ, chiều cao tự hút ñạt 3m. 
Ưu thế của bộ mồi là vận hành rất ñơn giản, ñổ 
nước vào buồng bơm cho ñến mức miệng sên 
buồng xoắn và khởi ñộng máy là ñược. ðặc biệt, 
với thiết kế bộ van một chiều ñóng kín lượng nước 
trong ống hút và buồng bơm ñược giữ lại, vì vậy 
những lần ñóng ñiện bơm lần sau không cần phải 
mồi thêm nước. Năm 2002, Viện tiếp tục cho ra 
ñời bộ tự mồi thế hệ 2 kiểu nằm ngang với những 
tính năng ưu việt hơn, chiều cao tự hút ñạt 3,5m. 
Tháng 3 - 2003, Tiến sĩ Trần Văn Công và ñồng 
nghiệp ñưa ra thị trường bộ tự mồi thế hệ 3, kiểu 
xiên với chiều cao tự hút ñạt 5m. Sau khi lắp ñặt 
và chạy thử nghiệm tại xã Biên Giang, Thanh Oai, 
Hà Tây thành công, gần 30 xã thuộc Hà Tây, Hà 
Nội, Bắc Ninh, Khánh Hoà... ñã sử dụng bộ tự mồi 
này ñem lại hiệu quả rất cao. Theo Tiến sĩ Trần 
Văn Công, bộ tự mồi thế hệ 3 rất ưu việt, thời gian 
mồi cũng rất nhanh; khi chiều cao hút càng thấp thì 
thời gian mồi càng ít. Qua thực tế, với chiều cao 
dưới hoặc bằng 4m, thời gian tự mồi lần ñầu chỉ 
mất khoảng 3-10 phút. 
 Nhờ có bộ tự mồi thế hệ 3, bơm ly tâm nông 
nghiệp ñã ñược vận hành hoàn toàn tự ñộng hoá. 
Ưu thế lớn nhất khi sử dụng bộ tự mồi là có thể 
ñóng ñiện liên tiếp cho nhiều tổ bơm và sau thời 
gian rất ngắn tất cả các tổ bơm ñược tự mồi và lần 
lượt làm bình thường mà chỉ cần 1 người vận 
hành. ðộ bền của bộ mồi khá cao, cho ñến nay sau 
sáu năm sử dụng, duy nhất có một bộ tự mồi của 
xã Hiền Giang (Thường Tín, Hà Tây) hỏng lá van 

cao-su và ñược thay thế một cách dễ dàng. Theo ông 
Công, giá thành của bộ tự mồi thế hệ 3 rất rẻ, loại lắp 
vào bơm có ñường kính ống D250.D300 chỉ 1,5 - 2,5 
triệu ñồng (tùy vật liệu). Ngoài bộ tự mồi cho máy 
bơm ly tâm lớn, Viện này cũng sản xuất các loại bộ 
tự mồi cho các loại máy bơm hộ gia ñình, trang trại 
theo ñơn ñặt hàng. 
                                 Theo Nông thôn ngày nay 

 
 

Chế tạo thành công ñộng cơ ñiện cho phương 

tiện giao thông 

 
  Năm giảng viên trẻ của bộ môn Gia công  vật liệu 
và dụng cụ công nghiệp (Trường ðại học Bách khoa 
Hà Nội) vừa nghiên cứu và chế tạo thành công sản 
phẩm ñộng cơ một chiều cảm biến vị trí dùng ñể ứng 
dụng trong nhiều lĩnh vực như: ñiều khiển tự ñộng, 
thiết bị y tế, hầm mỏ...; ñặc biệt có thể sử dụng cho 
xe ñạp, xe máy và ô-tô. 
 Theo Giáo sư, Tiến sĩ Bành Tiến Long Trưởng bộ 
môn Gia công vật liệu và dụng cụ công nghiệp, chủ 
nhiệm ñề tài khoa học thì ñây là sản phẩm ñầu tiên 
ñược sản xuất trong nước nhằm thay thế cho các ñộng 
cơ chạy bằng nhiên liệu xăng ñể giảm ô nhiễm môi 
trường và hạn chế tai nạn giao thông trong các ñô thị.  
Nhóm nghiên cứu cho biết: Ưu ñiểm kỹ thuật của sản 
phẩm này là loại ñộng cơ không dùng chổi than 
(brushless) nên hệ số an toàn cao, không phải mở 
ñộng cơ ñể thay chổi than ñịnh kỳ chạy êm và ñiều 
khiển tốc ñộ vô cấp. Sensor cảm biến vị trí theo từ 
trường nên có ñộ tin cậy và tuổi thọ cao trong các 
ñiều kiện có nhiệt ñộ, áp suất và ñộ ẩm biến ñổi. 
Mạch ñiều khiển ñược thiết kế thông minh và tối ưu 
theo nhiều mục tiêu như: tiết kiệm năng lượng, bảo 
vệ ñộng cơ khi quá tải và ñạt moment khởi ñộng lớn. 
Anh Trần Xuân Thái - một trong năm thành viên 
tham gia chế tạo sản phẩm phân tích: "Nếu ñộng cơ 
ñược dùng cho sản xuất xe máy thì trọng lượng xe sẽ 
nhẹ hơn 1/2 xe máy chạy bằng xăng như hiện nay; 
hình dáng xe gọn hơn và việc chế tạo cũng ít tốn kém 
hơn. ðối với người sử dụng thì sẽ tiết kiệm ñược 
khoảng 1/2 chi phí so với dùng xăng. ðặc biệt với tốc 
ñộ dưới 40 km/giờ, ñộng cơ sẽ rất phù hợp với giao 
thông ñô thị ở Việt Nam hiện nay, nó sẽ góp phần 
giảm ô nhiễm môi trường cũng như tai nạn giao 
thông". Anh Thái cũng cho biết hiện sản phẩm ñã 
ñược Công ty Xe ñạp Thống Nhất áp dụng ñể lắp cho 
xe ñạp, thay thế cho các ñộng cơ phải nhập khẩu 
trước ñây. 
                              Theo Thanh niên 
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NGÀNH  CƠ KHÍ CHẾ TẠO TRONG ðIỀU KIỆN KINH TẾ TRÍ THỨC 

        Nền kinh tế toàn cầu ñang ñi vào thời kỳ biến 

ñổi cơ bản : xã hội loài người từ thời ñại kinh tế 
công nghiệp bước vào thời ñại kinh tế tri thức. kinh 

tế tri thức cùng với khoa học – công nghệ cao thúc 

ñẩy ngành cơ khí chế tạo khí thay ñổi mang tính 

cách mạng, khi công nghệ cao trở thành cơ sở cho 

sản xuất, và trí tuệ, tài nguyên là ñiểm tựa cho kinh 

tế trí thức. 

         Khác với kinh tế nông nghiệp và công nghiệp, 

kinh tế trí thức lấy trí thức làm cơ sở cho nền kinh tế, 

ứng dụng tri thức và thông tin cho sản xuất, lấy sản 

phẩm làm chỗ dựa trực tiếp cho nền kinh tế tri 

thức.Kinh tế tri thức là kết hợp tất nhiên của tiến bộ 

công nghiệp hoá, là hình thức kinh tế cao cấp hơn 

kinh tế công nghiệp. Trong thời ñại kinh tế công 

nghiệp, yếu tố chính của sản xuất là vốn và sức lao 

ñộng. Trong thời ñại kinh tế tri thức, yếu tố chính 

của sản xuất là tri thức, vốn và sức lao ñộng, mà tri 

thức giữ vai trò hạt nhân. Tri thức ñược coi là ñộng 

lực yếu tố quyết ñịnh ñể nâng cao hiệu quả sản xuất 

và thực hiện  tăng trưởng kinh tế. Sự phát triển kinh 

tế tri thức gắn liền với sự phát triển khoa học công 

nghệ cao bao gồm: ðẩy mạnh nghiên cứu khoa học 

và công nghệ cao; ứng dụng công nghệ cao trên cơ 

sở cải tạo toàn diện các ngành sản xuất truyền thống. 

Quan hệ giữa cải tạo các ngành sản suất 

truyền thống với phát triển công nghệ cao là mật 

thiết, nhằm phát triển các lĩnh vực sản xuất có công 

nghệ cao ñáp ứng thị trường rộng lớn. Trong ñiều 

kiện kinh tế tri thức, công nghệ chế tạo cơ khí ñang 

phát triển nhảy vọt về chất. Công nghệ chế tạo cơ khí 

ñã trở thành công nghệ cao, tích hợp, ña   ngành, liên 

quan toàn bộ quá trình sản xuất. ðồng thời ñể hỗ trợ 

cho các ngành ñiện tử, quang học, tin học, sinh học 

và khoa học quản lý, công nghệ chế tạo dần trở thành 

công nghệ mới ra ñời của ngành chế tạo và hình thức 

tổng hợp của công nghiệp mới nổi lên. 

        Ngành chế tạo là cơ sở của nền kinh tế quốc 

dân, nó tạo  ra cho xã hội loài người 60-80% của cải. 

Những năm 80 của thế kỷ 20, trên toàn cầu ñã xuất 

hiện nhiều công nghiệp mới cho nên ngành chế tạo, 

ñặc biệt là ngành chế tạo cơ khí bị xem nhẹ. Vì vậy 

,năm 1993, Hội kỹ sư cơ khí chế tạo Mỹ ra lời kêu 

gọi toàn xã hội rằng : ”Ngành chế tạo hiện nay phải 

ñược phát triển lại“, và dùng con số ñơn giản nhất ñể 

khuyên nhân dân Mỹ: hơn nửa nguồn giá trị tổng sản 

phẩm kinh tế quốc dân và hoạt ñộng kinh doanh năm 

1992 của nước Mỹ là do ngành chế tạo trong, ñó có 

chế tạo cơ khí, mang lại. 

        Hai trăm năm lại ñây, do nhu cầu thị trường 

không ngừng biến ñổi, quy mô sản xuất của ngành 

chế tạo có su hướng phát triển là : ”từ tập trung lao 

ñộng sang tập trung thiết bị, sang tập trung thông tin, 

sang tập trung tri thức”. Tương ứng, phương thức sản 

xuất của ngành chế tạo cũng có hướng phát triển là: ” 

Thủ công sang cơ khí hoá, sang tự ñộng hoá ñơn 

máy, sang tự ñộng hoá dây truyền cứng sang tự ñộng 

hoá dây truyền linh hoạt, sang tự ñộng hoá thông 

minh”. 

        Ngành chế tạo truyền thống ñược xây dựng tuỳ 

theo quy mô và khối lựng sản xuất, cơ cấu sản phẩm 

và tính lặp lại, ña ngành ñược ưu thế cạnh tranh, sử 

dụng có hiệu quả tài nguyên, ñạt chất lượng và hiệu 

quả cao, kỹ năng nhờ dùng máy móc thay thế sức 

người, thiết bị gia công phức tạp thay thế con người. 

Trong ñiều kiện như vậy, tính không linh hoạt của 

máy móc, sản phẩm thiết kế theo tiêu chuẩn ñã khiến 

năng xuất  sản xuất cao, nhưng khó ñáp ứng nhu cầu 

của thị trường về ña dạng chủng loại và thời gian giao 

hàng. Vì vậy ngành chế tạo truyền thống trong thời 

ñại kinh tế tri thức cũng ñứng trước nhiều thách thức 

gay gắt. 

        Thế kỷ 21 là thời ñại mà quan hệ quốc tế ña cực, 

tiêu dùng ña dạng, kinh tế toàn cầu và thương mại tự 

do, tiến bộ khoa học - kỹ thuật và xã hội thông tin, 

coi trọng bảo vệ môi trường, khiến cho vai trò của 

ngành chế tạo nói chung, trong ñó ngành chế tạo cơ 

khí nói riêng, ñược các nước trên thế giới ngày càng 

coi trọng, phương thức sản xuất ñược cải tiến, và 

ñược yêu cầu ngày càng cao. Chu kỳ tuổi thọ của sản 

phẩm ngắn; nhu cầu của hộ sử dụng ña dạng hoá; Thị 
trường lớn và tính cạnh tranh khốc liệt; Thời gian 

giao hàng là yếu tố thứ nhất của cạnh tranh; Tin học 

hoá và trí tuệ hoá; Thay ñổi về tri thức, tố chất nhu 

cầu của con người; Tăng cường ý thức bảo vệ môi 

trường. 

        Cuối thế kỷ 20, khoa học công nghệ cao như vi 

ñiện tử, công nghệ tin học, vật liệu mới phát triển 

nhanh có tác dụng mạnh mẽ trong lĩnh vực  ñiều 

khiển ñược ứng dụng sâu rộng trong ngành chế tạo, 

ñã thay ñổi nhanh gọn phương 

pháp thiết kế, kết cấu sản phẩm phương thức sản 

xuất, công nghệ thiết bị sản xuất cùng với việc sản 

sinh ra kết cấu tổ chức của ngành chế tạo hiện ñại, 

ñã sinh ra công nghệ chế tạo và mô hình chế tạo 

mới. Ngành chế tạo hiện ñại ñã phát triển với tốc ñộ 

nhanh, sáng tạo cái mới và trí thức tập trung. Hàm 

lượng kỹ thuật của nhiều sản phẩm cơ khí ñã tăng, 

ñứng vào hàng sản phẩm công nghệ cao. Công nghệ 

chế tạo ñã mang lại biến ñổi to lớn cho ngành chế 

tạo chủ yếu là : Tối ưu hoá công nghệ chế tạo thông 

thường, là hình thành công nghệ chế tạo hiệu quả, 

chính xác, sạch, hiệu quả cao, chất lượng tốt, tiêu 
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hao ít, ô nhiễm môi trường chế tạo giảm, với tiền ñề 

là giữ nguyên lý công nghệ vốn có không ñổi, mà 

cải tiến tối ưu hoá công nghệ. Công nghệ thông 

thường ñến nay vẫn là kỹ thuật sử dụng trên diện 

rộng, có ý nghĩa kinh tế kỹ thuật to lớn. Phát triển 

phương pháp gia công mới phi truyền thống, nghĩa 

là, phải hình thành phương pháp gia công kiểu mới 

như : Kỹ thuật gia công lade, ñiện tử, siêu âm và 

phức hợp, v v. . . 

        Làm mờ nhạt và xoá hẳn giới hạn, giữa sản 

xuất và khoa học, trong nội bộ công nghệ chế tạo, 

dần tiến tới một thể thống nhất; phải xoá dần giới 

 

 hạn giữa gia công nóng lạnh, giữa quá trình gia 

công, quá trình kiểm tra ño lường, quá trình lắp ráp 

và thiết kế ứng dụng trong quá trình chế tạo, Thiết 

kế công nghệ dựa vào kinh nghiệm ñể tiến ñến phân 

tích ñịnh lượng, ñể xác ñịnh phương án công nghệ 

tối ưu, dự ñoán hỏng hóc và biện pháp phòng ngừa, 

ñiều khiển và ñảm bảo chất lượng chi tiết gia công 

thiết kế công nghệ làm cơ sở phán ñoán ñể tiến ñến 

phân tích ñịnh lượng công nghệ gia công và ñiều 

không kém phần quan trọng là phải kết hợp mật 

thiết kỹ thuật thông tin, kỹ thuật quản lý với công 

nghệ. 

             GS.TSKH  Nguyễn Anh Tuấn

80% tiêu chuẩn Việt Nam không phù hợp với quốc tế 
 ðây là con số ñược TS. Vũ Văn Diện, Giám ñốc Trung tâm Tiêu chuẩn Chất lượng của Tổng cục Tiêu chuẩn 

ðo lường Chất lượng ñưa ra trong Hội nghị Chất lượng Việt Nam lần thứ 5 ñược khai mạc sáng 2/10/2003 tại 

Hà Nội với chủ ñề ''Chất lượng, Cạnh tranh, Hội nhập kinh tế''.  

 Theo TS. Diện, hệ thống tiêu chuẩn Việt Nam (TCVN) hiện hành gồm khoảng 5.600 TC nhưng hầu hết ñều 

ñược ban hành trước năm 1990 và trên cơ sở tham khảo hoặc thống nhất với các tiêu chuẩn của Liên Xô cũ hoặc 

của các nước XHCN trước ñây. Các tiêu chuẩn này có các quy ñịnh và yêu cầu thường không thống nhất với các 

tiêu chuẩn quốc tế (TCQT) cũng như tiêu chuẩn của các nước trong khu vực. Hiện tại chỉ có 1.200 TCVN ñược 

ban hành trong những năm gần ñây là hài hoà với các TCQT tương ứng.  

 Việt Nam ñang tăng cường hội nhập kinh tế với các nước trong khu vực và trên thế giới nên việc hài hoà 

TCVN với TCQT thực sự là yêu cầu bức xúc. ðơn giản là vì tiêu chuẩn hài hoà quốc tế là ngôn ngữ chung ñể 

hai bên (trong hợp tác song phương) và nhiều bên (trong hợp tác ña phương), căn cứ vào ñó ñạt ñược sự thông 

hiểu khi thiết lập quan hệ ñối tác.  

 Việt Nam ñang hướng tới việc tham gia WTO trong thời gian tới, Việt Nam hiện lại là thành viên của APEC, 

ASEM, ASEAN... nên một trong những việc phải làm là không tạo thêm các rào cản kỹ thuật trong thương mại 

bằng các tiêu chuẩn và quy ñịnh kỹ thuật mới và xoá bỏ dần những rào cản kỹ thuật hiện hành. ðặc biệt là WTO, 

hài hoà tiêu chuẩn là 1 trong 5 nguyên tắc căn bản ñể xét cho các nước gia nhập tổ chức này. WB, tổ chức mà 

Việt Nam ñang nỗ lực ñể sử dụng có hiệu quả nguồn trợ giúp của họ cũng ñang rất quan tâm ñến tiêu chuẩn 

trong xúc tiến thương mại. Chương trình nghiên cứu gần ñây của WB về xúc tiến thương mại ñã xác ñịnh tiêu 

chuẩn và quy ñịnh như là những rào cản kỹ thuật trong thương mại.  

 Nhận ñịnh về tình hình hội nhập TCQT của các DN Việt Nam, Bà Nguyễn Thị Bích Hằng, Giám ñốc Trung 

tâm Năng suất Việt Nam cho biết: ''ðể tạo ñược một thương hiệu trên trường quốc tế, DN phải có những cam kết 

với chất lượng sản phẩm của mình mà ñầu tiên là việc áp dụng các hệ thống quản lý chất lượng theo tiêu chuẩn 

như ISO 9000... Tuy vậy, trong số  hàng chục nghìn DN hoạt ñộng trên thị trường Việt Nam, chỉ có khoảng 

1.200 DN ñã áp dụng và có chứng chỉ này. Còn nhiều DN vẫn chỉ áp dụng hệ thống này trên hình thức, vì mục 

ñích chứng chỉ hay quảng cáo sản phẩm. Tạo dựng thương hiệu từ nền tảng chất lượng là thách thức với DN Việt 

Nam nhưng là việc không thể không làm''.  

 Hiện trên thế giới có hơn 40 tổ chức quốc tế ban hành các tiêu chuẩn ñược coi là các tiêu chuẩn quốc tế và 

nhiều tổ chức khác ban hành ra các tiêu chuẩn ñược các nước khác chấp nhận rộng rãi. Một số hệ thống chất 

lượng phổ biến hiện nay:  

ISO 9000: Hệ thống quản lý chất lượng tác ñộng vào các yếu tố và quá trình tạo ra sản phẩm, dịch vụ ñảm bảo 

chất lượng với khách hàng.  

ISO 14000: Hệ thống quản lý môi trường, quản lý tác ñộng của hoạt ñộng, sản phẩm hoặc dịch vụ của DN ñến 

môi trường xung quanh, ngăn ngừa ô nhiễm và giảm chi phí cho DN thông qua tiết kiệm các nguồn lực ñầu vào.  

TQM: Quản lý chất lượng toàn diện, tác ñộng ñến mọi mặt hoạt ñộng của DN và trách nhiệm của từng bộ phận, 

cá nhân trong DN.  

GMP: Hệ thống thực hành sản xuất tốt, kiểm soát tất cả các yếu tố ảnh hưởng tới an toàn vệ sinh trong quá trình 

chế biến chủ yếu là thực phẩm và dược phẩm.  

HACCP: Hệ thống phân tích các mối nguy và xác ñịnh các ñiểm kiểm soát giới hạn nhằm ñảm bảo an toàn thực 

phẩm.          Theo VietNamNet 
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KỸ THUẬT NGƯỢC 

1. Mở ñầu 

Từ những năm ñầu thập niên 90 của thế kỷ trước, kỹ thuật ngược (Reverse Engineering) ñã ñược nghiên 
cứu áp dụng trong lĩnh vực phát triển nhanh sản phẩm, ñặc biệt là trong lĩnh vực thiết kế các mô hình 3D từ mô 
hình cũ ñã có nhờ sự trợ giúp của máy tính. Kỹ thuật ngược ngày càng phát triển theo sự phát triển của máy quét 
hình và các phần mềm CAD/CAM. 

Vậy kỹ thuật ngược là gì? 

Thông thường ñể gia công chế tạo sản phẩm thì người ta thiết kế mô hình CAD rồi ñem sang máy công 
cụ ñể gia công. Trong thực tế, ñôi khi người ta cần chế tạo theo những mẫu có sẵn mà chưa (hoặc không) có mô 
hình CAD tương ứng (ñồ cổ chẳng hạn), những chi tiết ñã ngừng sản xuất từ lâu, những chi tiết không rõ xuất 
xứ, những phù ñiêu, bộ phận con người, ñộng vật, … ðể tạo ñược mẫu của những sản phẩm này, trước ñây 
người ta ño ñạc rồi vẽ phác lại hoặc dùng sáp, thạch cao ñể in mẫu. Các phương pháp này cho ñộ chính xác 
không cao, tốn nhiều thời gian và công sức, ñặc biệt là những chi tiết phức tạp. Ngày nay người ta ñã sử dụng 
máy quéy hình ñể quét hình dáng của chi tiết sau ñó nhờ các phần mềm CAD/CAM chuyên dụng ñể xử lý dữ 
liệu quét và cuối cùng sẽ tạo ñược mô hình CAD 3D với ñộ chính xác cao. Mô hình 3D này có thể ñược chỉnh 
sửa nếu cần. Ngoài việc tái sử dụng sản phẩm, kỹ thuật ngược còn có một số ứng dụng sau:  

-  Kiểm tra chất lượng sản phẩm bằng cách so sánh mô hình CAD và sản phẩm, từ ñó ñiều chỉnh mô 
hình hoặc các thông số công nghệ ñể tạo ra sản phẩm ñạt yêu cầu. 

-  Mô hình CAD ñược sử dụng như là mô hình trung gian trong quá trình thiết kế bằng cách tạo sản 
phẩm bằng tay trên ñất sét, thạch cao, sáp …. rồi quét hình ñể tạo mô hình CAD. Từ mô hình CAD này người ta 
sẽ chỉnh sửa theo ý muốn. 

2. Quy trình kỹ thuật ngược 

 Quy trình kỹ thuật ngược có thể ñược diễn tả theo sơ ñồ sau : 

 

 

 

a. Giai ñoạn quét hình: 

  Dùng máy quét hình ñể quét hình dáng của vật thể. Có thể dùng máy quét dạng tiếp xúc(như máy ño toạ 
ñộ 3 chiều Coordinate measuring Machine -CMM) hoặc máy quét dạng không tiếp xúc (máy quét laser) 

Khi sử dụng máy CMM thì ñầu dò tiếp xúc với bề mặt cần ño. Mỗi vị trí ño sẽ cho một ñiểm có toạ ñộ 
(x, y, z). Tập hợp các ñiểm ño sẽ cho một ñám mây các ñiểm. 

Khi sử dụng máy quét laser thì chùm tia laser từ máy chiếu vào vật thể sẽ phản xạ trở lại cảm biến thu. 
Hình dạng của toàn bộ vật thể ñược ghi lại bằng cách dịch chuyển hay quay vật thể trong chùm ánh sáng hoặc 
quét chùm ánh sáng ngang qua vật. Phương pháp này cho ñộ chính xác kém hơn phương pháp tiếp xúc. 

Cả 2 phương pháp ñều cho dữ liệu vì chi tiết gồm tập các ñiểm (ñám mây ñiểm). ðám mây ñiểm này 
phải ñược chuyển sang dạng lưới (thường là lưới tam giác) ñể xây dựng mặt. 

b. Giai ñoạn xây dựng mặt : 

Giai ñoạn này bao gồm 3 bước: 

1. Xây dựng lưới từ ñám mây ñiểm. 

2. ðơn giản hoá lưới bằng cách giảm số lượng các hình trong lưới và tối ưu hoá vị trí các ñỉnh và cách 
kết nối các cạnh của mỗi hình ñơn trong lưới sao cho các ñặc ñiểm hình học không thay ñổi. 

3.  Chia nhỏ lưới (ñã ñược ñơn giản hoá) ñể tạo bề mặt trơn theo ý muốn. 

Kết quả là ta ñược một bề mặt trơn và ñược chuyển thành file CAD với các ñịnh dạng như : IGES, DXF, 

Quét 
hình 

ðám 
mây 
ñiểm 

Xử lý 
tạo mặt 

Mô hình 
CAD 

Tạo 
mẫu 
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STL … 

Các hình sau ñây mô tả một số công ñoạn quét hình ñầu người  nhờ máy CMM ñiều khiển bằng tay. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

c. Tạo mẫu : 
 Từ dữ liệu mô hình CAD, có thể áp dụng công nghệ tạo mẫu nhanh (Rapid Prototyping) ñể tạo mẫu sản 
phẩm. Cũng có thể tạo mẫu trên máy phay CNC, khi ñó phải lập trình NC nhờ các phần mềm CAD/CAM 
chuyên nghiệp như Cimatron, Pro/Engineer, GibCAM...ñể tạo ra các ñường chạy dao. Hình sau ñây minh hoạ 
quá trình phay mẫu mặt người trên máy phay CNC. 
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3.  Phần mềm hỗ trợ  
Các nhà chế tạo máy CMM khác nhau có những phần mềm chuyên dụng khác nhau. Các hãng phần 

mềm CAD/CAM cũng có modun tương tự trong phần mềm của mình ñể hỗ trợ cho việc quét hình và xử lý dữ 
liệu. Sau ñây là một số phần mềm thông dụng : 

-  GEOPARK-WIN của hãng Mitutoyo : Phần mềm này ñi kèm theo các máy CMM của hãng. Có thể 
xuất dữ liệu ở nhiều kiểu ñịnh dạng khác nhau, trong ñó có 2 kiểu ñáng chú ý là .gws (ñịnh dạng ASCII) và .igs 
(ñịnh dạng polyline). Phần mềm này ñang ñược sử dụng tại trường ðại học Bách khoa thành phố Hồ Chí Minh, 
Honda Việt Nam... 

-  CopyCAD : của hãng DELCAM. phần mềm này ñang ñược sử dụng tại một số công ty liên doanh sản 
xuất giày dép của ðài Loan tại khu công nghiệp Song Mây - ðồng Nai. 

-  TRACECUT : của hãng Renishaw 
-  GAGE2000R :Của hãng Brown and Shape 
-  Pro/Scan : một modun của phần mềm Pro/Engineer (hãng PTC). 
4. Sơ lược tình hình áp dụng kỹ thuật ngược tại Việt Nam :  
Tại Việt Nam, một số công ty, nhà máy cơ khí ñã ñược trang bị các máy CMM nhằm ño lường kiểm tra 

sản phẩm cơ khí như Honda Việt Nam, Vikyno... Một số công ty chế tạo trong nước cũng ñã nhanh chóng nắm 
bắt kỹ thuật này ñể ñáp ứng nhu cầu mẫu mã sản phẩm ngày càng ña dạng. Một vài trường ñại học cũng ñã trang 
bị máy này và bắt ñầu nghiên cứu ứng dụng kỹ thuật ngược. Trường ðại học Bách khoa thành phố Hồ Chí Minh 
ñã trang bị máy CMM Beyond A504 của hãng Mitutoyo. Trường kết hợp với một sô công ty khuôn mẫu, giày 
dép ñể nghiên cứu về kỹ thuật này.  Một số công ty liên doanh ở nước ta thường sử dụng kỹ thuật ngược này 
nhằm phát triển sản phẩm từ các chi tiết của máy móc mà họ nhập từ nước ngoài. Tất nhiên các sản phẩm này sẽ 
ñược sửa ñổi ñôi chút về hình dáng nhằm tránh vấn ñề bản quyền. 
          

Nguyễn Văn Tường 
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SỰ CẠNH TRANH CỦA CÔNG NGHỆ HÀN CHUYỂN ðỘNG MA SÁT 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
Hàn chuyển ñộng ma sát (Friction Stir 

Welding - FSW) ñược xem là một công nghệ hàn 
mới, ñang ñược ñưa vào sản xuất, ñặc biệt là ở 
Châu Âu và Nhật bản, với mục ñích là giảm chi phí 
và cải tiến chất lượng. Trước hết, chúng ta sẽ xem 
xét ñến quá trình cơ bản và chúng ñược so sánh với 
phương pháp hàn truyền thống ra sao. Sau ñó, xem 
thử vấn ñề sử dụng của FSW trong việc chế tạo 
những thành phần chi tiết phục vụ cho Panoz 
Esperante. 

Cơ sở của FSW: 
 Từ khi nó ñược phát triển lần ñầu tiên vào 
năm 1991 bởi viện TWI (The Welding Institute), 
hiển nhiên rằng nó là một một phương pháp hàn 
linh ñộng và ñơn giản, với nhiều ưu ñiểm từ việc cải 
tiến chất lượng cho ñến tiết kiệm chi phí. ðây là quá 
trình rất phù hợp với hàn kim loại nhôm, là một quá 
trình mà phương pháp hàn truyền thống khó thực 
hiện ñược. 

                          Hình 1 
 

 FSW hiển nhiên là ñơn giản, với chỉ một 
vài thông số. Một dụng cụ quay tròn bằng vật liệu 
không thiêu huỷ ñược ñâm vào bên trong và dịch 
chuyển xuyên suốt vật liệu hàn (Hình 1). Thành 

 phần chính của dụng cụ là phần vai và cực dò (pin). 
Trong suốt quá trình hàn cực dò di chuyển trong vật  
liệu trong khi vai (shoulder) chạy dọc trên bề mặt. 
Nhiệt ñược sinh ra bởi vai dụng cụ cọ sát trên bề 
mặt và bởi cực dò ở dưới vai dụng cụ. Chuyển ñộng 
hỗn hợp này cho phép vật liệu ñược dịch chuyển 
ngang qua ñường hàn. Thông số của quá trình là sự 
quay và tốc ñộ dịch chuyển và việc thiết kế dụng cụ, 
sự ñịnh hướng và ñịnh vị trí. Một trong những thông 
số ñược chọn là chất lượng của quá trình hàn. ðây 
là một quá trình hàn rất linh ñộng, nó có thể ñược 
sử dụng ñể hàn nhiều cấu trúc mối hàn khác nhau. 
Nó cũng hàn ñược bất kỳ hướng nào, chẳng hạn như 
hàn sấp, hàn ñứng, hàn trần, bởi vì trọng lực không 
có ý nghĩa trong quá trình này. Bởi vì quá trình 
không tạo ra nhiệt , nguyên nhân chủ yếu gây nên 
ñốt nóng cục bộ và nóng chảy kim loại, nên chất 
lượng của nó vượt xa so với những phương pháp 
hàn nóng chảy truyền thống.  
 Chi phí rất là thấp bởi vì không có sự tiêu 
hao vật liệu hàn (khí, que hàn), việc chuẩn bị hàn 
ñơn giản, không cần thiết phải bảo vệ môi trường, 
bởi vì không có khói và sự vung toé. Chất lượng 
gắn liền với những ưu ñiểm của nó bao gồm hình 
dáng và ñộ vững chắc của mối hàn, cải thiện sự 
cong vênh và ñộ bền. Quá trình này cũng tránh 
ñược những vấn ñề ñối với phương pháp hàn truyền 
thống. Những vấn ñề của phương pháp hàn nóng 
chảy bao gồm sự ngấu của mối hàn không cao, cơ 
tính vùng mối hàn thấp, thời gian hàn cao, vật hàn 
dễ cong vênh và biến dạng.  
 Ngoài quá trình trên còn có quá trình hàn 
ñiểm chuyển ñộng ma sát (Friction stir spot 
welding- FSSW). FSSW cũng tương tự như FSW 
nhưng dụng cụ ñược ñâm vào và nhất ra khỏi vật 
hàn. Sự dịch chuyển chi tiết của quá trình bị hạn 
chế. Một vài  ñiểm hàn  ñược biểu diễn ở hình 2.  
 

 
Hình 2. Một mối hàn ñiểm ma sát ñơn giản 

Các mối ghép như hàn ñiểm ñiện trở, ghép 
then, ghép ñinh tán, ghép bằng chốt là những 
phương pháp lắp ghép cổ ñiển và ngày nay chỉ áp 
dụng cho những mối ghép ñơn giản. Những vấn ñề 
của hàn ñiểm ñiện trở (Reistance spot welding - 
RSW) bao gồm: (1)  Cần phải làm sạch bằng cơ học 
kim loại nhôm trước khi hàn trong khoảng 8 giờ. (2) 
Hợp kim ñiện cực bị thừa trên mối hàn làm cho chất 
lượng mối hàn thấp.(3) Chu kỳ thời gian lâu bởi vì 
chu kỳ hàn ñược cần thiết ñể bù vào quá trình biến 
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dạng. Những vấn ñể của mối ghép ñinh tán là : (1) 
chi phí cho ñinh tán.(2) mất nhiều thời gian ñể hoàn 
thành mốI ghép.(3) cần phải khoan trước khi dùng 
ñinh tán.  
 Trong hàn FSSW không có sự ăn mòn. 
Dụng cụ có tuổi thọ cao vì thế khắc phục ñược mọi 
vấn ñề khó khăn của phương pháp hàn truyền thống. 
 Hàn FSW có thể hàn nhiều kết cấu khác 
nhau (hình 3) nhưng nó không có khả năng hàn mối 
hàn kiểu ñường gân chữ T (T-fillet), thông thường 
thì trường hợp này chỉ phù hợp cho hàn hồ quang. 

 
 

Hình 3. Các kiểu mối hàn của FSW 

Ứng dụng : 
Có nhiều ứng dụng ñốI với hàn FSW, ñặc 

biệt ứng dụng trong ngành sản xuất những sản phẩm  
nhôm. Gần ñây, bất kỳ những ứng dụng về ñinh tán, 
then và hàn hàn ñiểm ñiện trở ñều ñược thay bằng 
hàn FSW. Nhiều sản phẩm hàn hồ quang kim loại 
có lớp khí bảo vệ (GMAW) cũng có thể áp dụng 
cho hàn FSW.  
 Ngoài vật liệu nhôm ra, hàn FSW có thể áp 
dụng cho những vật liệu khác như ma-giê, ñồng, 
chì, titan và thép. Bề dày tấm ghép từ 0,5- 50mm. 
Những chi tiết bằng nhôm trong ôtô ñược tính toán 
thiết kế lại ñể phù hợp với hàn FSW và tránh ñược 
những vấn ñề khó khăn của quá trình lắp ghép 
truyền thống. Hàn FSW thay thế hàn hồ quang bởi 
vì hàn hồ quang không có hiệu quả hoặc không ñáp 
ứng ñược yêu cầu ñặt ra. Những mặt tồn tại của hàn 
hồ quang cho thấy răng: Trong quá trình kiểm tra 
những mối hàn GMAW, người ta thấy rằng mối hàn 
bị hỏng sớm. những chi tiết cần yêu cầu có ñộ bền 
thì phải gia cố thêm thanh thép  vào thì  mới hàn 
ñược. ðây là một quá trình tốn rất nhiều nhân công 
và nhiều khâu công nghệ. 
 ðể khắc phục những vấn ñề trên, một 
mụctiêu ñược ñưa ra là phải thay thế hàn hồ quang 
bằng hàn FSW nhằm mục ñích ñể giảm chi phí công 
nghệ.  
 Những kết cấu ñược ứng dụng cho hàn 

FSW phải ñảm bảo những ñiều kiện sau: 
- FSW nối những kết cấu khác nhau: Sử 

dụng phương pháp xuyên thấu tấm ghép hoặc hàn 
theo ñường viền tấm ghép, tránh hàn theo kiểu T-
fillet 

-  Yêu cầu về lực là rất quan trọng: Chi tiết 
và bộ phận kẹp chặt phải ñược thiết kế ñể phù hợp 
những lực tác dụng.  
 Hàn FSW ñạt ñược những kết quả sau: 

- Các kết cấu hàn FSW ñạt ñược tải làm việc 
gấp 2,5 lần so với những kết cấu hàn 
GMAW 

- Hàn FSW ñạt ñược ñộ bền lớn hơn 20%  so 
với hàn hồ quang, 

Dụng Cụ FSW.  
Gần ñây ñể ñạt ñược những yêu cầu ñối với 

hàn FSW, những máy hàn FSW ñược trang bị theo 
yêu cầu ñặt ra có thể  phục vụ cho vấn ñề sản xuất. 
Tuy nhiên, ñể tiến xa hơn nữa người ta sẽ  trang bị 
một robot công nghiệp  dùng ñể hàn nhằm nâng cao 
năng suất sản xuất. Những loại máy hàn ñược trang 
bị  thường là máy một trục ñơn và máy nhiều trục. 
Với robot công nghiệp cho phép giảm chi phí sản 
xuất, cải tiến qui trình sản xuất và giúp cho FSW 
ñược ứng dụng trong nhiều lĩnh vực khác nhau. 
 Ứng dụng cụ thể là có 10 mối hàn trong 
một vùng hàn nhỏ, với mối hàn bề mặt ứng với 4 
hướng hàn khác nhau. Dựa trên những ñặc tính này, 
những ứng dụng này sẽ làm cho thiết bị có thể hàn ở 
bất kỳ những vị trí và những hướng khác nhau. 

So sánh về chi phí. 
Hàn FSW ñã ñược ứng dụng nhiều trong 

công nghiệp, vì vậy cần phải phân tích về chi phí 
của công nghệ này. Phân tích chi phí ñầu ra là dạng 
chi phí cho chi tiết hoặc là chi phí cho mỗi ñường 
hàn. Ban ñầu, phân tích ñầu vào bị hạn chế về chi 
phí và về sự hao mòn như dụng cụ FSW, ñiện, khí 
bảo vệ, que hàn và những chi phí khác như chi phí 
cho tăng thời gian sản xuất, các kim loại vụn và chi 
phí sửa chữa. Tuy nhiên những chi phí này tuỳ 
thuộc vào sự ứng dụng và yêu cầu về kinh nghiệm 
sản xuất. 

ðể phân tích ñược chi phí, những chi tiết 
hàn FSW sẽ ñược so sánh với hàn hồ quang tay 
GMAW Phân tích thiết bi dựa trên hệ thống robot 
FSW và robot GMAW. 

Nhìn chung, chi phí về thiết bị hàn thì cả 
hai qui trình bằng nhau. Mặt dù chi phí cho những 
bộ phận của thiết bị hàn GMAW (như que hàn, 
năng lượng ñiện, bộ ñiều chỉnh, ..) thì thấp hơn 
nhiều so với hàn FSW (trục và năng lượng ñiện). 
Nhưng số lượng thành phần chi tiết trong hàn 
GMAW thì nhiều hơn so với thiết bị hàn FSW. Việc 
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sử dụng ñầu vào ñể tính toán chi phí ñược biểu diễn ở (hình 4). Trong hình 4 cho thấy chi phí cho việc hàn 
GMAW cao khoảng 20% so với hàn FSW. 

 

 
Hình 4 

 
Kết luận 
Hệ thống hàn FSM  với robốt công nghiệp mang lại những lợ ích to lớn trong nhiều ứng dụng khác 

nhau. Trong một vài ứng dụng thì hàn FSM thay thế cho những công nghệ truyền thống như thay thế cho hàn 
RSW, ñinh tán. Hàn FSM không phải là giải pháp ma thuật ñầy uy lực nhưng khi thiết kế chế tạo cần phải cân 
nhắc ñến những ñặc ñiểm của hàn FSM,  khi ñó cơ hội thành công sẽ cao hơn với những lợi ích mà hàn FSM 
mang lại. 
         Nguyễn Hữu Thật 
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CHƯƠNG TRÌNH KC.03 - CÁC ðỀ TÀI ðANG THỰC HIỆN 
1. Nghiên cứu thiết kế chế tạo các hệ SCADA ñặc thù diện rộng hoạt ñộng trong ñiều kiện thiên nhiên và 
môi trường khắc nghiệt 
Mã ñề tài: KC-03-01 (01/10/2001 - 01/10/2004)  
Chủ nhiệm ñề tài: GS.TSKH Cao Tiến Huỳnh (ðịa chỉ: 89B Lý Nam ðế - ðiện thoại: 8456574)  
Mục ñích: Nghiên cứu tiếp cận các vấn ñề khoa học công nghệ hiện ñại liên quan ñến các hệ thống SCADA diện 
rộng; Nghiên cứu thiết kế chế tạo hệ thống SCADA ñặc thù, trong ñó có nhiều ñối tượng giám sát và ñiều khiển 
phân bố trên những vùng rộng lớn, ở cách xa nhau và cách xa trung tâm,...  

2. Nghiên cứu thiết kế chế tạo Robot phục vụ cho quá trình sản xuất trong các ñiều kiện ñộc hại và không 
an toàn 
Mã ñề tài: KC-03-02 (01/10/2001 - 31/12/2004)  
Chủ nhiệm ñề tài: TS.Lê Hoài Quốc (ðịa chỉ: 268 LýThường Kiệt, P14,Q10,TP HCM - ðiện thoại: (84-
8)8637318, (84-8)8655348)  
Mục ñích: Xây dựng cơ sở lý luận, phương pháp thiết kế và phương pháp ñiều khiển ñể chế tạo các robot, tay 
máy phục vụ trong các quá trình ñộc hại và không an toàn, cụ thể là trong quá trình nhiệt luyện, trong nghành 
ñóng tàu, nghành nhựa, trong quá trình nạp thuốc súng, chất nổ....  

3. Nghiên cứu thiết kế,chế tạo các thiết bị TðH chế biến nông sản 
Mã ñề tài: KC-03-03 (01/10/2001 - 31/10/2004)  
Chủ nhiệm ñề tài: TS.Nguyễn Năng Nhượng (ðịa chỉ: Nhà A2, Phương Mai,ðống ða, Hà Nội - ðiện thoại: (84-
4)8523187 - 8522724)  
Mục ñích: Chế tạo ñược các thiết bị và hệ thống tự ñộng hoá phục vụ cho chế biến nông sản thay thế nhập ngoại.  

4. Nghiên cứu thiết kế, chế tạo hệ thống SCADA phục vụ an toàn lao ñộng trong ngành khai thác hầm lò 
Mã ñề tài: KC-03-04 (01/10/2001 - 31/10/2004)  
Chủ nhiệm ñề tài: GS.TSKH Nguyễn Xuân Quỳnh (ðịa chỉ: 156AQuán Thánh, Ba ðình,Hà Nội - ðiện 
thoại: (84-4)7164380)  
Mục ñích: Tự thiết kế chế tạo ñược hệ SCADA phức hợp ña thông số (như CH4, CO2, CO, NOx, SOx, SH2, ...) 
cho nghành khai thác hầm lò, nâng cao ñộ chính xác, ñộ tin cậy và tính ổn ñịnh của hệ thống. 

5. Nghiên cứu ứng dụng công nghệ TðH và gia công chính xác trên cơ sở các công nghệ tiên tiến như 
Lazer,Plasma và tia lửa ñiện... 
Mã ñề tài: KC-03-05 (01/10/2001 - 31/12/2002)  
Chủ nhiệm ñề tài: Thạc sĩ ðỗ Văn Vũ (ðịa chỉ: 46 Láng Hạ, ðống ða, Hà Nội - ðiện thoại: (84-4) 8344372)  
Mục ñích: Nghiên cứu, thiết kế, chế tạo trong nước các thiết bị gia công chính xác trên cơ sở công nghệ Tự ñộng 
hoá hiện ñại kết hợp các công nghệ tiên tiến như Lase, Plasma và tia lửa ñiện... thay thế hàng nhập ngoại.  

6. Nghiên cứu thiết kế chế tạo SCADA ñảm bảo môi trường nuôi trồng thuỷ sản phục vụ xuất khẩu 
Mã ñề tài: KC-03-06 (01/10/2001 - 31/10/2004)  
Chủ nhiệm ñề tài: Thạc sĩ Nguyễn Duy Hưng (ðịa chỉ: 156AQuán Thánh, Ba ðình,Hà Nội - ðiện thoại: (84-
4)7164380)  
Mục ñích: Thiết kế hệ thống SCADA phù hợp phục vụ hoàn thiện từng bước hệ thống quản lý và ñiều hành môi 
trường nuôi trồng thuỷ sản nhằm nâng cao chất lượng hàng hoá, ñảm bảo hỗ trợ phát triển môi trường thuỷ sản 
bền vững.  

7. Nghiên cứu thiết kế chế tạo thiết bị và hệ thống thông minh phục vụ ñào tạo và nghiên cứu trong lĩnh 
vực TðH và các công nghệ cao khác thay cho nhập ngoại 
Mã ñề tài: KC-03-07 (01/10/2001 - 31/10/2004)  
Chủ nhiệm ñề tài: PGS.TS Nguyễn Công Hiền (ðịa chỉ: Trung tâm công nghệ cao - ðHBK HN, Số1- ðại Cổ 
Việt- Hai Bà Trưng- Hà Nội - ðiện thoại: (84-4)8680753 - 8680754)  
Mục ñích: Nghiên cứu thiết kế chế tạo thiết bị và hệ thống thông minh phục vụ ñào tạo và nghiên cứu trong lĩnh 
vực TðH và các công nghệ cao khác thay cho nhập ngoại.  

8. Nghiên cứu thiết kế chế tạo các Robot thông minh phục vụ cho các ứng dụng quan trọng 
Mã ñề tài: KC-03-08 (01/11/2001 - 30/11/2004)  
Chủ nhiệm ñề tài: GS.TSKH Nguyễn Thiện Phúc (ðịa chỉ: C107, ðại Học Bách Khoa, ðại Cổ Việt, Hà Nội -
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 ðiện thoại: (84-4)8692207)  
Mục ñích: Tự thiết kế và chế tạo các module cấu thành các robot thông minh, trong ñó có các module robot song 
song, phục vụ cho các ứng dụng trong sản xuất.  

9. Nghiên cứu thiết kế chế tạo các phần tử và hệ thống ñiều khiển theo nguyên lý phỏng sinh học 
Mã ñề tài: KC-03-09 (01/08/2001 - 31/12/2003)  
Chủ nhiệm ñề tài: PGS.TS Nguyễn Tăng Cường (ðịa chỉ: 100 Hoàng Quốc Việt, Cầu Giấy, Hà Nội - ðiện 
thoại: (84-4)7542281 - 7544248)  
Mục ñích: Nghiên cứu, thiết kế, chế tạo các phần tử và hệ thống ñiều khiển theo nguyên lý phỏng sinh học  

10.Nghiên cứu xây dựng giải pháp tổng thể và hệ thống tự ñộng hoá tích hợp toàn diện phục vụ cho các 
doanh nghiệp 
Mã ñề tài: KC-03-10 (01/10/2001 - 31/10/2003) 
Chủ nhiệm ñề tài: TS. Phạm Ngọc Tuấn (ðịa chỉ: 27/49 B Hậu Giang, phường 4, quận Tân Bình, TP HCM -
 ðiện thoại: (84-8)8429329 - 0903678459)  
Mục ñích: Nghiên cứu, xây dựng giải pháp tổng thể và hệ thống tự ñộng hoá tích hợp toàn diện phục vụ cho các 
doạnh nghiệp  

11. Nghiên cứu thiết kế chế tạo các hệ SCADA phục vụ cho ngành năng lượng và cấp nước sạch thay thế 
cho nhập ngoại 
Mã ñề tài: KC-03-11 (01/10/2001 - 31/10/2004)  
Chủ nhiệm ñề tài: PGS.TS Nguyễn Trọng Quế (ðịa chỉ: 46 Nguyễn Văn Ngọc, Phường Cống Vị, Quận Ba ðình, 
Hà Nội - ðiện thoại: (84-4)7660467 (6 lines))  
Mục ñích: Nghiên cứu, thiết kế, chế tạo hệ thống SCADA cho nghành ñiện thay thế hàng nhập ngoại  

12. Nghiên cứu thiết kế chế tạo các bộ ñiều khiển số (CNC) thông minh và chuyên dụng cho các hệ thống 
và quy trình phức tạp 
Mã ñề tài: KC-03-12 (01/10/2001 - 30/04/2004)  
Chủ nhiệm ñề tài: TS.Thái thị Thu Hà (ðịa chỉ: 268 Lý Thường Kiệt, Quận 10, TPHCM - ðiện thoại: (84-
8)86373318)  
Mục ñích: Nghiên cứu xây dựng phương pháp thiết kế và tích hợp bộ ñiều khiển CNC trên cơ sở ứng dụng 
phương pháp ñiều khiển song song, tối ưu ñiều khiển thích nghi và những thành tựu khai thác về phương pháp 
ñiều khiển trong ngành chế tạo máy.  

13. Nghiên cứu, thiết kế và chế tạo các thiết bị tự ñộng ño lường và kiểm tra thông minh phục vụ cho các 
dây chuyền sản xuất Tự ñộng hoá 
Mã ñề tài: KC-03-13 (01/10/2002 - 31/10/2004)  
Chủ nhiệm ñề tài: PGS.TSKH. Phạm Thượng Cát (ðịa chỉ: ðường Hoàng Quốc Việt,Nghĩa ðô, Cầu Giấy, Hà 
Nội. - ðiện thoại: 7564405)  
Mục ñích: - Thiết kế và chế tạo các thiết bị ño lường và kiểm tra thông minh thay cho nhập ngoại. - Nghiên cứu 
phát triển các phương pháp, thuật toán xử lý và cấu trúc hệ thống của các thiết bị, hệ thống ño lường thông minh.  

14. Nghiên cứu phát triển và hoàn thiện các hệ thống tự ñộng hoá quá trình khai thác dầu khí ở Việt Nam 
Mã ñề tài: KC-03-14 (01/10/2001 - 31/10/2003)  
Chủ nhiệm ñề tài: TS. Phạm Hoàng Nam (ðịa chỉ: Công ty AIC - 217 ðường La Thành - Hà Nội - ðiện 
thoại: (84-4)5111018)  
Mục ñích: Tạo ra sản phẩm công nghệ cao phục vụ cho công tác thăm dò và dầu khí ở Việt Nam  

15. Hoàn thiện và nâng cao mức ñộ ñộng hoá cho các loại trạm trộn bê tông và các trạm trộn thức ăn gia 
súc, phân bón 
Mã ñề tài: KC-03-DA01 (01/10/2001 - 01/10/2003)  
Chủ nhiệm ñề tài: Th.S Mai Văn Tuệ (ðịa chỉ: 156A Quán Thánh - Ba ðình - Hà Nội - ðiện thoại: (84 - 4) 
7164841)  
Mục ñích: Hoàn thiện về mọi mặt (ñộ ổn ñịnh, tin cậy, chính xác, kiểu dáng công nghiệp,...) các sản phẩm hiện 
ñang ứng dụng ñể tạo ra sản phẩm công nghiệp chất lượng cao, nâng cao mức ñộ tự ñộng hoá cho các loại trạm 
trộn và hệ thống ñịnh lượng.  

    Nguyễn Văn Tường    (theo http://www.vspa.gov.vn/) 
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MÁY ĐO TOẠ ĐỘ 
Nguyễn Văn Tường 

  Máy đo toạ độ (Coordinate Measuring Machine –CMM) là tên gọi chung của các thiết bị vạn năng có 
thể thực hiện việc đo các thông số hình học theo phương pháp toạ độ. Thông số cần đo đựoc tính từ các toạ độ 
điểm đo. Các loại máy này còn được gọi là máy quét hình vì chúng còn được dùng để quét hình dáng của vật thể. 
Có hai loại máy đo toạ độ  thông dụng là máy đo bằng tay (đầu đo được dẫn động bằng tay) và máy đo CNC 
(đầu đo được điều khiển tự động bằng chương trình số). 
  

 
 

Hình 1. Kết cấu máy CMM. 
 

Máy đo toạ độ thường là các máy đo các 3 phương chuyển vị đo X, Y, Z như hình 1. Bàn đo 14 được lắp 
trên đế 15.Trên bàn đo có lắp thước kính và đầu đọc 16 để đọc toạ độ theo phương Y, dẫn động đầu đọc theo 
phương Y là mô tơ 8. Xe số 7 trượt theo trục Y mang đầu đọc 16 để đọc toạ độ theo phương Y. Trên cầu X lắp 
trên xe 7 có gắn thước kính và đầu đọc toạ độ theo phương X. Đầu đọc 19 gắn trên xe 5 được dẫn động nhờ mô 
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tơ 6. Xe 5 mang hai ống rỗng dùng dẫn trượt  đầu đo theo phương Z. Đầu đo được gắn trên giá đầu đo 17 lắp 
trên thân trượt theo phương Z. Khi đầu đo được điều chỉnh đến một điểm đo nào đó thì 3 đầu đọc sẽ cho ta biết 3 
toạ độ X, Y, Z tương ứng với độ chính xác có thể lên đến 0,1 µm. 
 Loại máy đo này có chuyển vị rất êm, nhẹ nhàng nhờ dùng dẫn trượt trên đệm khí nén. Để kết quả đo tin 
cậy, áp suất khi nén cần phải được bảo đảm như điều kiện kỹ thuật của máy đã ghi nhằm đảm bảo đệm khí đủ áp 
suất và làm việc ổn định. Các máy của hãng Mitutoyo thường có yêu cầu áp suất khi nén là 0,4MPa với lưu 
lượng 40 lít/phút ở trạng thái bình thường. Máy phải được vận hành ở nhiệt độ thấp, thường từ 160C đến 260C.  
 Loại máy được dẫn động bằng tay vận hành đơn giản, nhẹ nhàng nhờ dùng dẫn trượt bi, tuy nhiên loại 
này có độ chính xác thấp hơn.  
 Máy đo 3 toạ độ có phạm vi đo lớn. Nó có khả năng đo các thông số phối hợp trên một chi tiết. Ví dụ 
như hình 2, sau một số điểm đo, thường lấy 3 điểm, trên mặt A máy ghi nhận vị trí mặt A, sau một số điểm đo 
trên mặt B, thường lấy 6 điểm trên 2 thiết diện. Với những kết quả đo được, phần mềm của máy giúp ta tính 
được độ không vuông góc của mặt A với đường tâm tâm của mặt B, độ trụ của mặt B...Đặc biệt máy có thể cho 
phép đo các chi tiết có biên dạng phức tạp, các bề mặt không gian, ví dụ như bề mặt khuôn mẫu, cánh chân vịt, 
mui xe ô tô... Đặc biệt là nó được ứng dụng trong kỹ thuật ngược. 

  
Hình 2.Ví dụ đo độ vuông góc trên máy đo CMM. 

 
Để dễ dàng cho việc tính toán kết quả đo, kèm theo máy là phần mềm thiết kế trước cho từng loại thông 

số cần đo. Mỗi hãng chế tạo máy CMM đề có viết riêng cho các máy của mình những phần mềm khác nhau. Mỗi 
phần mềm có thể có nhiều môđun riêng biệt ứng dụng cho từng loại thông số cần đo. Ví dụ máy CMM của hãng 
Mitutoyo có các phần mềm (môdun) như sau : 
 - GEOPAK : có nhiều cấp độ khác nhau, dùng cho đo lường vật thể 3D, có thể xuát sang file dạng .gws 
để chuyển đổi dữ liệu đo thành dữ liệu chuỗi điểm cho thiết kế chi tiết bằng phần mềm Pro/Engineer hoặc các 
phần  mềm khác. 
 - SCANPAK : dùng để số hoá biên dạng 3D của vật thể, chuyên dùng cho kỹ thuật ngược. 
 - STATPAK : chuyên dùng để xử lý số liệu đo. 
 - GEARPAK INVOLUTE/BEVEL : chuyên dùng cho đo bánh răng, chuyển dữ liệu từ máy CMM sang 
máy kiểm tra bánh răng. 
 - TRACEPAK : chương trình quét vật thể 3D cho máy CMM vận hành bằng tay. 
 - Ngoài ra còn một số phần mềm khác như : COM3D, PLOT-GEO, 3DTOL 
 
 
Tài liệu tham khảo 
[1]. Ninh Đức Tốn. Dung sai lắp ghép. NXB Giáo dục 2000. 
[2]. http://www.mitutoyo.com.sg/  
 
 
 
 
 
 
 

http://www.mitutoyo.com.sg/
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GIỚI THIỆU MÔ ðUN PRO/MOLDESIGN 
 

 1 Công dụng của mô ñun Pro/Moldesign  

 Pro/MOLDESIGN là một mô ñun của phần mềm Pro/ENGINEER nhằm cung cấp các công cụ cho quá 

trình thiết kế khuôn. Mô ñun này giúp ta tạo, hiệu chỉnh và phân tích các thành phần của khuôn và lắp ráp khuôn, 

nhanh chóng cập nhật những thay ñổi trong mẫu thiết kế. 

 Các công cụ mà mô ñun này cung cấp là : 

-    Phân tích nếu mẫu thiết kế có thể tạo khuôn ñược, dò và chỉnh sửa các vùng khó tạo khuôn. 

-  ðịnh lại kích thước mẫu theo hệ số co rút tùy thuộc vào vật liệu, hình dáng hình học mẫu thiết kế  và 

ñiều kiện ñúc. 

- Tạo các mẫu thiết kế một hoặc nhiều lòng khuôn. 

- Tạo lõi và các bộ phận tạo nên hình dáng vật ñúc. 

- Tạo các thành phần tiêu chuẩn như ñế khuôn, chốt lói sản phẩm, lỗ phun nhựa, ñường dẫn nhựa, ñường 

nước làm mát… 

- Kiểm tra sự  cản trở giữa các thành phần của khuôn khi mở khuôn. 

Sau khi tạo khuôn, các thành phần của khuôn ñược  xem như những chi tiết riêng biệt và có thể sử dụng mô 

ñun Pro/NC ñể tạo ra ñường chạy dao CNC gia công chi tiết. 

 
 

2. Quá trình thiết kế khuôn 

Sơ ñồ khối quá trình thiết kế khuôn ñược mô tả như sau : 

 
 
 
 
 
 
 

 
 
 
 
 
 
 

Pro/ENGINEER 

Pro/MOLDESING
E 

Thieát keá chi tieát (maãu) 

Thieát keá laép raùp khuoân: 
- Theâm maãu tham chieáu. 
- Theâm phoâi. 

Laép raùp caùc baûn veõ 
saûn phaåm 

Ñònh laïi kích thöôùc maãu theo 
heä soá co ruùt 
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Phaân tích maãu tham chieáu cho 
goùc vaùt, ñoä daøy. 

Maãu coù caàn theâm goùc vaùt, daøy 
hôn, moûng hôn, maët caét cho 

khaû naêng taïo khuoân. 

Ñònh maët phaân khuoân 
vaø/hoaëc caùc nöûa khuoân. 

Ñoåi maãu thieát keá hoaëc 
theâm ñaëc tính khuoân 
cho maãu tham chieáu. 

Taïo maãu khuoân cho caùc 
phaàn töû cheøn vaøo 

Taùch khuoân baèng caùc maët 
maãu vaø caùc nöûa khuoân 

Trích caùc theå tích khuoân 

Taùch khuoân coù ñoøi hoûi 
taïo theå tích khuoân ? 

Theâm bao nhieâu nöûa 
khuoân ? 

1                     2 

Taùch moät nöûa 
khuoân 

Taùch hai 
nöûa khuoân 

 Coù 

Coù 

Khoâng 
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 Quá trình thiết kế khuôn với Pro/Moldesign bao gồm các bước ñiển hình sau ñây : 

     1. Tạo mẫu cần làm khuôn hoặc lấy một mẫu sẵn có. 

2.Tạo phôi. 

  3.Thực hiện kiểm tra sơ bộ trên mẫu tham chiếu ñể xác ñịnh nó có thoát ra từ khuôn một cách dễ dàng 

hay không. 

Ñònh kích thöôùc maët phaân 
khuoân vaø hoaëc nöûa khuoân 

Trích caùc nöûa khuoân thaønh 
caùc phaàn töû ñaëc Baûn veõ chi tieát 

Taïo khuoân ñuùc 

Môû khuoân, moâ phoûng vaø  
kieåm tra giao thoa 

Theâm ñeá khuoân 

Phaùt hieän giao thoa 

Thieát keá raõnh roùt, ñöôøng 
daãn nhöïa vaø cöûa daãn nhöïa 

Taïo loã choát ñaåy saûn phaåm, 
theâm choát ñaåy vaø ñoà gaù 

Hoaøn thieän baûn veõ saûn phaåm 
laép raùp 

Hoaøn thieän baûn veõ chi tieát 

Thaønh phaàn maùy CNC 

Taïo ñöôøng nöôùc 

Taïo choát ñaåy saûn phaåm 

Coù 

Pro/NC 

Pro/DETAIL 
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 4.ðịnh lại kích thước mẫu theo hệ số co rút. Có thể tạo tỉ lệ co rút ñẳng hướng hay áp dụng chug một hệ 
số co rút cho một vài hay tất cả các kích thước. 

5.Xác ñịnh các thể tích hay các mặt phân khuôn ñể chia phôi thành những phần riêng rẽ. 

6.Tách khuôn thành các khối (các nửa khuôn). Các khối này có vai trò như một chi tiết riêng biệt, có thể 
ñược sử dụng trong chế ñộ Part, Drawing, Machine với Pro/NC… 

7.Tạo cổng phun nhựa, ñường dẫn nhựa. 

8. ðiền ñầy lòng khuôn ñể tạo dáng vật ñúc. Hệ thống tạo dáng vật ñúc một cách tự ñộng bằng cách xác 

ñịnh thể tích còn lại trong phôi sau khi trừ các phần tách ra. 

9. Xác ñịnh các bước (khoảng cách) mở khuôn. Kiểm tra sự va chạm với các phần cố ñịnh. ðiều chỉnh 

các thành phần của khuôn nếu cần… 

 10. Kiểm tra sự ñiền ñầy khuôn. 

10. ðánh giá kích thước ban ñầu của khuôn và chọn ñế khuôn thích hợp. 

11. Lắp ráp các bộ phận của khuôn nếu cần. Các bộ phận cơ bản của khuôn như cơ cấu kẹp, tấm ñỡ, chốt 

ñẩy sản phẩm… sẽ ñược hiển thị dọc theo mẫu, chúng có ích cho sự hình dung quá trình mở khuôn. 

12. Hoàn thành thiết kế chi tiết. 
13. Mang các thành phần của khuôn vào Pro/NC ñể thực hiện quá trình gia công. 

         Nguyễn Văn Tường 
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S1 

H1 

H 

N 

R 

H2 

α 

O 

O1 

O2 

S2 

Hình 2 

 

 

HÌNH CẦU NỘI TIẾP TRONG HÌNH NÓN, MỘT CÔNG CỤ LÝ THÚ ðỂ GIẢI MỘT SỐ BÀI 
TOÁN TRONG HÌNH HỌC HOẠ HÌNH 

Một bài toán hình học coi như giải ñược nếu chỉ dùng thước và compa ñể giải. Theo cách giải thông 

thường thì hoặc dài dòng, hoặc không chính xác. Do ñó cần phải tìm một cơ cấu phụ trợ thích hợp ñể giải quyết 
thì chúng thành ñưn giản hơn. Bài báo này xin giới thiệu một cấu hình phụ trợ là "mặt cầu nội tiếp trong hình 

nón" cho phép giải ñược một loạt bài toán khó trong hình học hoạ hình, ñôi lúc dùng cách thông thường không 

giải ñược. 

* Một số tính chất của cấu hình: 

1. Có thể thay thế ñường tròn ñáy nón tròn xoay bởi một hình cầu nội tiếp mà ñường tròn tiếp xúc chính 

là ñường tròn ñáy nón, do ñó không phải vẽ các ellip là hình chiếu của ñường tròn ñáy nón (Hình 1a và Hình 1b) 

2. Trong trường hợp trên, nếu một mặt phẳng tiếp xúc với nón thì cũng tiếp xúc với cầu. Ngược lại, một 

mặt phẳng ñi qua ñỉnh nón và tiếp xúc với cầu thì cũng tiếp xúc với nón (Hình 1b). 

3. Có nhiều hình nón tròn xoay ngoại tiếp cho một hình cầu (Hình 1c) và ngược lại có nhiều hình cầu nội 

tiếp trong một hình nón tròn xoay (Hình 1d). 

4. Hình nón tiếp xúc với hình nón, hình cầu tiếp xúc với hình cầu hoặc hình nón tiếp xúc với hình cầu thì 

ñều có một mặt phẳng tiếp xúc chung tại tiếp ñiểm. 

Bài 1. Hãy vẽ các ñường sinh biên của một hình nón tròn xoay có ñường cao là SH cho trước và có góc 

ñáy là a. 

Bài giải: Thay vì việc vẽ ñường tròn ñáy nón 

(mà hình chiếu là ellip), ta lập một hình cầu nội tiếp sao 

cho ñường tròn tiếp xúc là ñường tròn ñáy nón. Nói cách 

khác là ta thay hình nón xác ñịnh bởi ñỉnh S và ñường 

tròn ñáy bằng một hình nón xác ñịnh bởi ñỉnh S và một 

hình cầu, như vậy ñường sinh biên của nón khi nào cũng 

là một tiếp tuyến của ñường tròn trên các hình chiếu. 

Trước tiên ta tìm ñộ lớn thật của một nửa mặt cắt qua 

trục SH của hình nón, ñó là tam giác vuông SHN trong 

này góc N là góc ñáy và bằng α. Từ ñó ta suy ra tâm cầu 

nội tiếp là O và bán kính là R = NO (Hình 2) 

Qua O1 và O2 ta vẽ hai ñường tròn bán kính R 

thì các ñường sinh biên trên hình chiếu ñứng là 2 tiếp 

tuyến xuất phát từ S1 với ñường tròn O1 và trên hình 

chiếu bằng là 2 tiếp tuyến xuất phát từ S2 với ñường tròn 

tm O2. 

Bài 2. Qua ñiểm E cho trước, lập một mặt phẳng 

Q nghiêng với P2 một góc a và với P1 một góc b. 

S 

H 

S 

H 

M 
O 

S 

O O 

O’ 

S 

Hình 1 

a) 
b) c) d) 
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S3 

M3 

N3 N1 

N2 

S1=O1 

E1=O2 

V1Q V1Q’ 

V2Q V2Q’ 

β 

α 

E3 E1 

O 

O3 

Hình 3 

 

 

Bài giải: Trước tiên ta lập một hình nón ñỉnh E có trục vuông góc với P2 và có góc ñáy là a rồi lấy một 

hình cầu nội tiếp bên trong tuỳ ý. Sau ñó lập một hình nón thứ 2 có ñỉnh S có trục vuông góc với P1 và có góc 

ñáy bằng b, cũng ngoại tiếp cho hình cầu trên. Suy ra SE là ñường cạnh. 

Ta dùng hình chiếu cạnh ñể giải 
cho dễ dàng hơn (Hình 3). Bây giờ ta vẽ 
hình chiếu ñứng của ñáy nón ñỉnh S và 

hình chiếu bằng của ñáy nón ñỉnh E, rồi 

từ hình chiếu cạnh ta suy ra vết ñứng N1 

và vết bằng M2 của ñường cạnh SE.  

Qua N1 ta vẽ V1Q và V1Q' tiếp 

xúc với ñường tròn ñáy nón ñỉnh S và 

qua M2 kẻ V2Q và V2Q'. ðó là các cặp 

vết của mặt phẳng Q và mặt phẳng Q' 

cần tìm. Theo tính chất 2, mặt phẳng 

chứa SE sẽ tiếp xúc ñược với 2 hình 

nón, do ñó tiếp xúc với hình cầu. 

Bài 3. Cho 2 ñiểm M và N. Qua 

M lập một mặt phẳng Q hợp với mặt 
phẳng R bất kỳ một góc a và cách ñiểm 

N một khoảng r. 

Bài giải: Mặt phẳng qua M phải tiếp xúc với một hình cầu tâm N bán kính r và phải tiếp xúc với một 

hình nón ñỉnh M, góc ñáy a, có trục tròn xuay vuông góc với mặt phẳng R. ðể dựng mặt phẳng Q qua M tiếp với 

cả mặt cầu và mặt nón ta làm như sau: 

Trước tiên ta ngoại tiếp cho hình cầu một hình nón ñỉnh T ñồng dạng với hình nón ñỉnh M, có trục TI 

cũng vuông góc với mặt phẳng R. Sau ñó tìm vết V của ñường thẳng MT trên mặt phẳng R. Từ V kẻ hai tiếp 

tuyến chung của hai ñáy nón, thì ñó là hai vết bằng của hai mặt phẳng Q và Q' thoả mãn ñiều kiện của bài toán 

(Hình 4). Chú ý rằng V là tâm ñồng dạng phối cảnh của hai hình nón nên các tiếp tuyến chung phải cắt nhau. 

ðể ñơn giản, trước hết hãy biến ñổi hình chiếu ñể mặt phẳng R thành mặt phẳng bằng, rồi mới giải. 
Ngoài ra, cấu hình phụ trợ trên còn ñược dùng cho nhiều bài toán khác: 

1. Cho ba ñiểm A, O và O'. Lập một mặt phẳng qua A cách ñiểm O một khoảng r và cách ñiểm O' một ñoạn r'. 

2. Lập một mặt phẳng tiếp xúc với ba hình cầu cho trước. 

3. Dựng hai mặt nón tròn xoay ñồng dạng và tiếp xúc nhau, cho trước hai ñỉnh S và R, hai trục tròn xoay Sx và 

Ry. 

4. Cho ba ñiểm A, O và O'. Qua A kẻ một ñường thẳng cách ñiểm O một khoảng r và cách ñiểm O' một ñoạn r'. 

5. Cho mặt phẳng P bằng hai vết (V1P, V2P) một trục xoay X là chiếu bằng và một ñiểm A. Hãy xoay mặt phẳng 

P quanh X tới vị trí mới P' cách A một  ñoạn bằng d. 

         Trần Doãn Hùng 

M 

T 

V 

N 

α  
Q 

Q’ 

Hình 4 

R 
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BASIC DRAWING 2 
1. Tạo lỗ :Lệnh Hole 

Lệnh Hole dùng ñể tạo ra các lỗ lỗ có tiết diện bất kỳ. Khi vào lệnh này có các tuỳ chọn ñặt lỗ sau : 

- Linear  :  ðặt cách hai cạnh của một chi tiết. 

- Radial : ðặt lỗ cách trục một khoảng và cách mặt phẳng tham chiếu một góc. Thường dùng ñể tạo các 

lỗ toà tròn. 

     - Coaxial : ðặt tâm của lỗ cùng một trục hiện có (ñồng tâm) 

    - On point : ðặt tâm của lỗ trên một ñiểm                                                         

  Các kiểu lỗ: 

    - Straight : Lỗ suốt có ñường kính không ñổi. 

       -  Sketched : Lỗ có biên dạng bất kỳ do người vẽ tự phát thảo  

     -  Standard : Tạo các lỗ chuẩn  

    Các tuỳ chọn về chiều sâu lỗ :  

  -  Thru all : Lỗ thông 

  - Variable : Lỗ ñáy phẳng, chiều sâu lỗ do người dùng ấn ñịnh  

  -  Thru next : Cắt lỗ theo mặt một bộ phận kế tiếp  

-  Thru untill : Cắt lỗ theo mặt một do người dùng chọn 

- To reference : Cắt theo một ñiểm, ñỉnh, ñường cong hay mặt do người dùng chọn, lỗ có ñáy phẳng 

     -  Symmetric : Tạo lỗ ở hai bên rìa có chiều sâu. 

   

2.   BO TRÒN : Lệnh Round  

  Khi sử dụng lệnh Round ñể tạo các chi tiết tròn cần chú ý :  

  -  Các chi tiết ở cuối tiến trình tạo mô hình    

            -  Tạo các chi tiết tròn nhỏ trước, lớn sau 

  -  Tránh sử dụng dạng hình học tròn làm thành phành tham chiếu ñể tạo ra chi tiết     

  -  Nếu phải phát thảo một bề mặt thì hãy phát thảo trước rồi sau ñó mới tạo chi tiết tròn 

  Các tuỳ chọn Round Radii :  
   -  Constant : Bán kính không ñổi 

  - Variable : Bán kính biến ñổi, các giá trị bán kính ñược xác ñịnh từ cuối các ñoạn nối chuỗi    

   -  Thru curve : Xác ñịnh bán kính của một chi tiết dựa trên một ñường cong ñược chọn  

   -  Full round : chọn một chi tiết tròn hay cho một bề mặt ñược chọn 

           Các tuỳ chọn Reference : 

  - Edge chain : Chọn các cạnh ñể bo tròn  

- Surf-surf : chọn hai bề mặt ñể ñặt một chi tiết tròn. Chi tiết tròn sẽ ñược tạo giữa 2 bề mặt này 

- Edge - surf : ñặt một chi tiết tròn giữa một mặt và một cạnh  

- Edge-pair : mặt giữa hai cạnh ñược chọn sẽ ñược thay thế bằng một chi tiết tròn.  

     Các tuỳ chọn trên menu CHAIN : 

- One-By one : Chọn từng cạnh riêng vẽ. 

- Tangent chain : Các cạnh tiếp xúc ñược chọn . 

- Surf chain :  Các cạnh ñược chọn theo các bề mặt ñược chọn.  

  - Unselect : Huỷ chọn một phần tham chiếu. 

3. TẠO GÂN : Lệnh Rib 

                 Create - Rib  

4.  LỆNH PATTERN  
             Dùng ñể tạo nhiều trường hợp của một chi tiết bằng cách tạo ra các bản sao của nó. Hai cấu hình mẫu 

sẵn có là Linear và Angular. 

              Các tuỳ chọn :  

  - Indenfical Pattern : Các trường hợp của Indenfical Pattern phải cùng kích  cỡ và nằm tròn cùng một 

mặt, không giao với các chi tiết khác, các trường hợp hay cạnh của mặt phẳng ñặt. 

  - Varying Pattern : Các trường hợp của Varying Pattern biến ñổi và nằm trên các bề mặt khác nhau, 

không giao với các trường hợp khác . 
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  - General Pattern : Là mẫu phức tạp nhất. Các trường hợp của General   Pattern có thể giao với các 

trường hợp khác và các cạnh của mặt phẳng ñặt mẫu, các trường hợp có thể có kính cở biến ñổi và trên các bề 

mặt khác nhau. 

      Tuỳ chọn của menu PAT DIM  INCR : 

      - Value : Các giá trị kích thước ñược tăng lên. 

      -  Relation : Các quan hệ ñược sử dụng ñể ñiều khiển biến ñổi kích  thước.  

     - Table : Sự biến ñổi kích thước ñược ñiều khiển theo bảng. 

       

Các ví dụ : 

 Ví dụ 1 :  Vẽ chi tiết như hình 1 

1. Tạo chi tiết cơ bản : 50*30*20 bằng phương pháp ñùn 

2. Tạo hai mặt trụ : 

Create - Protrusion - Extrude - Solid - Done - One Side - Done chọn mặt phẳng phía trên hộp làm 

phẳng vẽ phác - Okay - Default - Specify Refs, chọn hai sợi chỉ này giao nhau giữa màn hình, chọn  nút No 
Hidden. 

Sketch - Circle - vẽ phác thảo hai vòng tròn như hình 2, Modify các kích thước : ñường kính ñường tròn 

10, khoảng cách từ tâm ñến ñường chuẩn là 12.5, xong chọn Done - Blind - Done nhập chiều sâu 10, Enter - 
OK- View- Defaut. 

 

Hình 5.1                       Hình 5.2 

3. Bo tròn : 

Create - Round - Simple - Done - Constant - Edge chain -Done - One By One - Done, chọn cạnh 

giao giữa hai trụ và mặt phẳng - Done nhập bán kính 2 , ENTER - OK 

4. Tạo mặt vát :  

Create - Chamfer - Edge, trên menu SCHEME  chọn 45*d nhập kích thước vát là 1, ENTER - Done 
Sel - Done Refs - Okay. Kết quả như hình 3. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Hình 3 

5. Tạo lỗ ñồng trục  

1 

2 

3 
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Create - Hole - Straight - Done - Coaxial - pick ñường tâm của trụ tròn. Xuất hiện dòng nhắc : Select 

the placement plane, pick lên mặt trên của trụ, One side - Done- Thru all, nhập ñường kính là 5, ENTER - OK. 

6. Tạo lỗ tuyến tính với tuỳ chọn Linear :  

 Create-Hole - Straight-Done ñể tạo một lỗ suốt . Chọn Linear - Done ñể khai báo phương pháp xác 

ñịnh tâm lỗ là cách hai mặt bên một ñoạn nào ñó. 

 Xuất hiện dòng nhắc : Select The Placement Plan, Pick chuột lên mặt 1 của hộp (hình 3), bốn cạnh của 

hộp nổi bật lên nghĩa là mặt ñã ñược chọn. 

 Xuất hiện dòng nhắc : Select TWO edges, axes, Planar Surface or Datums for Dimensioning, pick chuột 

lên cạnh 2 rồi gõ 10, ENTER, pick cạnh 3 rồi gõ 25, ENTER. 

 One Side - Done - Thru All - Done, xuất hiện dòng nhắc : ENTER DIAMETER : 10, ENTER. Kết quả 

như hình 4. 

 

 

 

 

 

 

 

 

 

 

 

 

  Hình 4        Hình 5 

7. Bo tròn các cạnh : 

Feature - create - Round - Advanted - Done - Add - Constant - Edge chain - Done - One By - One 
ñể chọn từng cạnh, chọn 4 góc ở ñỉnh - Done- nhập giá trị bán kính là 2,  ENTER- Ok 

Add - Constant - Edge chain - Done - One By One, chọn 4 cạnh của mặt trên - Done. Nhập giá trị bán 

kính là 1, ENTER - Ok - Done Sets - OK- View - Default. Kết quả như hình 5. 

 

Ví dụ 2 :Vẽ chi tiết như hình 11. 

1. Tạo chi tiết hình hộp 80x50x10. 

2. Tạo mặt phẳng DTM4 cách mặt DTM1 một khoảng 20 

Create - Datum - plane - Offset - chọn DTM1 - Enter Value : nhập 20, Enter (chú ý hướng mũi tên) - 

Done  

                       Hình 6          Hình 7 

 

3. ðùn một hình trụ mà tiết diện là hình tròn có tâm nằm trên mặt trên của tấm, bán kính 10mm. Kéo về bên phải 

một lượng 60mm, mặt phẳng vẽ phác là DTM4. 

4. Tạo lỗ ñồng trục ñường kính 10mm trên chi tiết vừa kéo, chú ý chọn tuỳ chọn UpTo Surface là mặt bên phải 

của tấm (hình 7). 

5. Tạo lỗ thẳng ñường kính 10mm, cách hai cạnh của  tấm 10mm.  

 

 

A 
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           Hình 8                    Hình 9 

6. Tạo một mẩu tuyến tính : 

Feat - Pattern, chọn lỗ vừa tạo - Identify - Done. Chọn kích thước 10 theo chiều dài tấm. Xuất hiện 

dòng nhắc nhập gia số kích thước, nhâp vào 40, Enter - Done. Xuất hiện dòng nhắc số trường hợp cần copy (kể 

cả mẫu gốc), nhập vào 2, Enter. 

Chọn kích thước 10 theo chiều rộng tấm. Xuất hiện dòng nhắc nhập gia số kích thước, nhập vào 30, 

Enter - Done. Xuất hiện dòng nhắc số trường hợp cần copy (kể cả mẫu gốc), nhập vào 2, Enter. Kết quả như 

hình 9 

7. Cắt : chọn mặt phẳng vẽ phác là DTM4, chuẩn kích thước là ñường tâm thẳng ñứng của ñường  tròn và chu vi 

của nó. Bề rộng cắt là 10  mm, chiều sâu cắt là 20mm (hình 10). 

 

     Hình 10             Hình 5.11 

8. Tạo gờ : mặt phẳng vẽ phác là DTM3, góc nghiêng của gờ so với ñường nằm ngang là 200, bề dày của gờ là 

5mm. Kết quả như hình 11. 

 

         Nguyễn Văn Tường 
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IN DỌC, IN NGANG TRONG WORD 

1. Cách in trang bài viết vừa theo hương giấy 

ngang (Landscape), vừa theo hướng giấy dọc 

(Portrait) 

  Ví dụ trong trường hợp bài viết của bạn có 100 

trang, cứ 10 trang dọc thì có 5 trang ngang. Vì thế, 

bạn cần phải in bài viết theo hướng giấy dọc 10 

trang ñầu, trang thứ 11 ñến 15 theo sau thì in theo 

hướng giấy ngang, 10 trang kế tiếp lại theo hướng 

dọc và 5 trang kế tiếp nữa thì phải in theo hướng 

ngang, cứ thế cho tới hết. Nếu làm theo thủ công, 

bạn sẽ lưu bài viết theo 2 loại tập tin: loại tập tin bài 

viết hướng dọc và loại tập tin bài viết hướng ngang. 

ðiều này rất bất tiện khi in vì bạn phải in cả chục 

tập tin như vậy hay khi gửi mail thì phải gửi mail cả 
chục lần. ðể in bài viết này với một tập tin duy nhất 

(gồm cả hướng giấy ngang và giấy dọc) thì bạn phải 

chèn ngắt trang trên trang 10, và thay ñổi hướng in 

cho trang 11. Ta cần thực hiện các bước sau: 

 - Di chuyển ñiểm chèn xuống cuối trang 10. Từ 
Menu chọn Insert -> Break -> Continuous (trong 

Section Break) -> OK 

 

 - Nếu sử dụng Word 97: Từ menu File -> Page 

Setup -> thẻ Paper Size -> Landscape (trong phần 

Orientation). Lưu ý phải chọn This Section trong 

phần Apply to. 

 - Nếu sử dụng Word XP: Từ menu File -> Page 

Setup -> thẻ Margins, phần Orientation chọn 

Landscape. Lưu ý phải chọn This Section trong 

phần Apply to.  

  Lúc này trang thứ 11 sẽ theo hướng ngang. 

Tương tự, bạn ñưa ñiểm chèn xuống cuối trang 15 

và thực hiện các thao tác như trên và chọn Portrait 
thì trang 16 theo hướng dọc... 

 

2. ðánh số thứ tự trang lặp lại theo từng chương: 
 - Bước 1: Di chuyển ñiểm chèn xuống cuối trang cuối 

cùng của chương 1. Từ menu Insert -> Break -> Next 

Page -> OK. lặp lại thao tác này cho chương 2, 3, 4... 

 

 - Bước 2: ðặt ñiểm chèn tại trang ñầu tiên của chương 

1. Từ Menu chon View -> Header and Footer. Xuất 

hiện thanh công cụ Header and Footer, ta chọn nút 

Switch Between Header and Footer ñể ñánh số trang ở 
vị trí ñầu trang hay cuối trang. Sau ñó chọn nút Insert 

Page Number ñể ñưa số thứ tự trang vào. 

 - Bước 3: ðặt ñiểm chèn tại trang ñầu tiên của chương 

2. Tại vị trí Footer hay Header, chọn Same As Previous 

> Format Page Number >Start at (số thứ tự sẽ là 1). 

Lặp lại thao tác này cho chương 3, 4, 5... (lưu ý không 

chọn nút Same As Previous nữa). 

 
  

  Theo http://ktlehoan.com/  
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LATHE : MÁY TIỆN 
 

-Lathe bed :  Băng máy  

-Carriage :    Bàn xe dao 

-Cross slide : Bàn trượt ngang 

-Compound slide: Bàn trượt hỗn hợp 

-Tool holder: ðài dao 

-Saddle:       Bàn trượt  

-Tailstock:   Ụ sau 

-Headstock: Ụ trước 

-Speed box: Hộp tốc ñộ 
-Feed (gear) box: Hộp chạy dao 

-Lead screw:      Trục vít me 

-Feed shaft:       Trục chạy dao  

-Main spindle:   Trục chính 

-Chuck:                 Mâm cặp 

-Three-jaw chuck: Mâm cặp 3 chấu 

-Four-jaw chuck:  Mâm cặp 4 chấu 

-Jaw:  Chấu kẹp 

-Rest:  Luy nét 

-Steady rest:    Luy nét cố ñịnh 

-Follower rest: Luy nét di ñộng 

-Hand wheel:  Tay quay 

-Lathe center:  Mũi tâm 

-Dead center:   Mũi tâm chết (cố ñịnh) 

-Rotaring center: Mũi tâm quay 

-Dog plate:      Mâm cặp tốc 

-Lathe dog :    Tốc máy tiện 

-Bent-tail dog: Tốc chuôi cong 

-Face plate :    Mâm cặp hoa mai 

-Automatic lathe:   Máy tiện tự ñộng 

-Backing-off lathe: Máy tiện hớt lưng 

-Bench lathe:         Máy tiện ñể bàn 

-Boring lathe:       Máy tiện-doa, máy tiện ñứng 

-Camshaft lathe:    Máy tiện trục cam 

-Copying lathe:      Máy tiện chép hình 

-Cutting –off lathe: Máy tiện cắt ñứt 

-Engine lathe:  Máy tiện ren vít vạn năng 

-Facing lathe:  Máy tiện mặt ñầu, máy tiện cụt 
-Machine lathe: Máy tiện vạn năng 

-Multicut lathe: Máy tiện nhiều dao 

-Multiple-spindle lathe : Máy tiện nhiều trục chính 

-Precision lathe:            Máy tiện chính xác 

-Profile-turing lathe:     Máy tiện chép hình 

-Relieving lathe:           Máy tiện hớt lưng 

-Screw/Thread-cutting lathe:  Máy tiện ren 

-Semiautomatic lathe: Máy tiện bán tự ñộng 

-Turret lathe: Máy tiện rơ-vôn-ve 

-Turret: ðầu rơ-vôn-ve 

-Wood lathe : Máy tiện gỗ 

ðính chính : Trong tập san số 1 chúng tôi in sai : Cross feed : chạy dao dọc, xin sửa lại là chạy dao 

ngang; In sai : Longitudinal feed : chạy dao ngang , xin sửa lại là : chạy dao dọc.Xin chân thành cáo lỗi bạn ñọc. 
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